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IntroductIon
 
Welcome to Basics of A+CAD 2008.  By learning how to work with A+CAD, you are joining over a million others who use this 
IntelliCAD-based computer-aided design software to draft drawings. A+CAD is exciting software, because it has many of the features 
of CAD software costing ten times as much — yet is very similar to the market leader, AutoCAD®.

Basics of A+CAD, strives to make you efficient in using basic commands and understanding fundamental concepts.  For more detailed 
curriculum and information for transitioning AutoCAD® users to A+CAD 2008 see the printed text “Inside A+CAD 2008”.

This book is written to teach the fundamentals of the software program A+CAD 2008.  A+CAD is a key component of The CAD 
Academy’s package to help educators prepare students to learn the same type of technology that they may be exposed to in industry. 
The A+CAD technology offers the industry standard compatibility with AutoCAD®-native DWG files, commands, applications, and 
command set as well as programming APIs, such as LISP and SDS (A+CAD’s application programming interface). A+CAD opens, 
edits, and saves any existing DWG files saved in numerous versions, including DWG Version 2.5 through 2008 without conversion  
or data loss. This means you can get to work immediately using the DWG files, commands, and applications you rely on. Current  
AutoCAD® users will realize a smooth transition and should feel comfortable making the switch.

Student’s success in this course is directly related to his or her ability to understand how to proceed in traditional and  
non-traditional class settings.  It is imperative for students to:
 

1. Read all material carefully.  Reread the material several times for total understanding. DO NOT SKIM.

2. Understand the concept of an activity before you start entering commands on the keyboard.

3. The information you will type is presented in numbered sequence.  Follow the steps carefully,  
watching the screen as you proceed.

4. Read the concepts again if you are having difficulty understanding a particular item.

5. Repeat the steps of an exercise over and over to develop mastery.  Mastery means you are able to complete  
an exercise without looking at the book, and understand why you performed that particular function.

6. Ask questions if you do not understand or if you are having difficulty with the keystrokes.
 

The Basics of A+CAD resources are flexible and instructors should feel comfortable supplementing curriculum resources  
that they have found successful throughout the years.

We welcome your suggestions, and hope that you will become apart of the collaborative effort in educating our  
future engineers and architects. 
 



About the Author
 
Dr. Don Bilse was in charge of the Drafting Technology program at Glendale Community College for over 20 years.  Glendale Com-
munity College is part of the Maricopa Community College District which is the largest community college district west of the Missis-
sippi.  He has been in technology education at both the community college and at the university level for over 40 years.  This book was 
used in an open/entry open/exit for beginning students and also for articulation between the high schools and the community colleges.  
The problems in this book have been tested by students and instructors over the years.  

This text was originally intended to be used with AutoCAD® and was converted/revised by Ralph Grabowski to use the A+CAD 
technology.  Ralph Grabowski is one of the foremost CAD authors in the world.  He has been writing about AutoCAD since 1985 and 
is the author of over 100 books in CAD.   In addition, Mr. Grabowski is the former Senior Editor of CADalyst magazine, the original 
magazine for AutoCAD users.
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chapTeR oNe

dRaWiNG # 1 – happy face

iNTRodUcTioN To a+cad 

Only a two decades ago, drawing with a computer was a new 
concept. Today computer-aided drafting (CAD) is standard. With 
each new release of CAD, the powerful software packages per-
form enhanced functions at faster rates. As the complexity of the 
programs increases, the software manufacturers strive to make 
the software easier to use. A+CAD 2008 is an example of such a 
product, and is the software we are using for this course. It is very 
powerful and can create creditable drawings for both home and 
office use. 

sTaRTUp pRocedURes
hard disk system

The following instructions are based upon a machine that has 
A+CAD 2008 already installed on the hard drive. The installa-
tion procedures used by most software companies today creates a 
shortcut icon that opens the software and takes you directly to the 
desired program. 

As you create and edit drawings in these tutorials, the drawings 
will be stored on the computer’s hard disk. It is good practice to 
make backup copies elsewhere, such as on a USB key (thumb-
drive) or CD-R disc. Be sure to save your files in both locations 
for added safety.

pRepaRiNG To dRaW

Pick the start button at the very lower left corner of your screen, 
then choose programs, then The cad academy, and then 
A+CAD 2008. Alternatively, double-click the a+cad 2008  
icon on the desktop to open the program. 

When A+CAD 2008 appears, a Tip of the Day dialog box might 
also show up. If so, move the cursor to oK button, and the click 
the left mouse button to dismiss the dialog box.. 

The mouse contains two or more buttons. The left button is the 
one used most often with this software. It selects commands and 
locates objects. The right button is used less often, usually to ac-
cess shortcut menus that appear at the cursor. If the mouse has a 
roller wheel, it can be used for “zooming” -- making the drawing 
larger and smaller.

After A+CAD 2008 loads, it becomes ready for drawing. Figure 
1.A shows you what the screen (computer monitor) looks like 
when the program is ready for drawing.

Figure 1.A

There are several things and terms you need to know before you 
can successfully draw. 

MeNUs

The “menus” are located at the top of the program. Each menu 
is categorized and contains commands that perform functions 
descriptive of the menu title. For example, contained within the 
Insert menu are commands like line, arc, and circle that are used 
to create the drawing entities. In the Modify menu are commands 
which manipulate the lines, arcs, circles, etc.. When you pick on 
a menu name, the menu displays all of the commands within that 
menu category.

coMMaNd pRoMpT  

When you select (pick) a command, you expect the command to 
operate. To be certain that you have selected the command, you 
must check the “command prompt” area at the very bottom of the 
screen. Note the lower left corner of Figure 1.A. If the command 
prompt does not specify the name of the command you have just 
picked from the pull down screen, the command will not function 
and you must reactivate the command.

Operating features within the selected command are displayed in 
the command prompt area. You must continuously check the 
command prompt and follow the instructions displayed. The 
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displayed instructions will tell you exactly what steps the soft-
ware wants you to follow in order to complete the command. if 
you don’t follow the command prompt instructions carefully, 
you will become frustrated! What you believe to be occurring, 
and what the software sees may be two different things. Read the 
command prompt area carefully.

TooLbaRs

If your screen does not look like Figure 1.A, you may need to 
add (or subtract) toolbars which contain the icons you may want 
to use. Icons are the small pictures shown near the top and right 
of the drawing area. The icons are programmed to perform in the 
same manner as when you activate a menu item.

To activate a toolbar (group of icons) not shown on the screen, 
pick the View menu, then Toolbars. A dialog box will appear 
and show you what toolbars are already active. If you wish to add 
additional toolbars, pick the small white square shown next to the 
toolbar’s name. See Figure 1.B.

Figure 1.B
To “store” the toolbar so that it is not in the middle of your draw-
ing area, pick on the blue bar at the top of the toolbar and then 
push it into the edge of the screen. Toolbars are amorphous and 
will take on the shape of the area they are pushed into. If you’ve 
never done this before, activate a couple of toolbars and then 
“push” them into the side or top of your drawing area. To pull 

toolbars away from their existing position, put the pointer/cur-
sor over the double vertical bar on the left side of the toolbar and 
slide the toolbar out onto the open space of the monitor.

beGiNNiNG To dRaW

Each drawing you create is designed to acquaint you with new 
commands. Basic functions like drawing lines, erasing what you 
have drawn, and clearing the screen with the Redraw command 
will become second nature after only a few minutes of operation. 

Do not be afraid to experiment. The charts in the appendix show 
you the menus you will be using and the commands associated 
with them. Note what each menu category of commands does. 
Analyzing and understanding each category will make it easy for 
you to learn the command structure. If you forget what com-
mands are in a category, simply highlight the menu category by 
placing the pointer over the title and clicking the left button of 
the mouse. The menus will “pull down” showing you what com-
mands are avail¬able in that category.

Remember that repetition is the key to success. Go over each new 
command several times until you are comfortable with it. Do not 
be afraid to experiment.

 DRAWING # 1  Happy Face

Objective: This exercise will familiarize you with numerous com-
mands in the Insert menu, such as Spline, Arc, Circle, Single Line 
Text, and Rectangle. It will also acquaint you with commands 
from the File, Edit, and Modify menus.

 

Figure 1.1
Each step necessary to construct the drawing is in this exercise. 
Follow each step carefully and watch how your computer re-
sponds to the different commands you give.
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 CONCEPT

A very important concept to understand in A+CAD 2008 
is how to select a menu and then select a command from 
the menu. To select a menu item, position the tip of the 
pointer with the mouse over the desired menu title in the 
top portion of the screen until the name of the desired 
menu title is highlight¬ed. Click the left button on the 
mouse to select. Once the menu title is selected, it will 
display a pull down menu from the title. To select a com-
mand under a menu, point to the desired command, until 
highlighted, then click the left mouse button.

• You may terminate a command or select a new  
command at any time simply by picking a new menu 
item or by tapping the ESC key. If you are “in the mid-
dle” of the desired command, but wish to start over from 
the beginning, tap the ESC (top left key on keyboard) 
or simply repick the desired command from the menu. 
Now, let’s begin our first drawing by starting with the 
Rectangle command.

1. position the pointer over the menu title insert.

 • Insert becomes highlighted.

2.  click the left mouse button.

 • The Insert menu elongates to show the  
commands in its area.

3. position the pointer over the Rectangle command 

4. click the left mouse button to activate the  
Rectangle command.

 • You are now ready to begin drawing a box.

 • The “Rectangle” command should now show in the 
command prompt area at the bottom of the screen. 

(Alternatively, you can pick the Rectangle icon 
from the Draw 2D toolbar. The rectangle icon 
is shown at the right.)

5. position the crosshairs near the upper left corner 
 of the screen.

 • The tip of the arrow illustrates where the  
rectangle will begin.                                 

 
 • To initiate a starting point, you will place the pointer 

(crosshairs) where you would like to begin and click  
the left mouse button.

6. click the left mouse button.
 
 • This locks in the starting point of the rectangle.

7. drag the cursor to the right to begin forming a box. 
  
 • Move the cursor to form a wide box --- or down to  

form a big box --- or move to the left to form a tall  
narrow box.

8. When you have a big box on the screen, click the left 
 mouse button.

 • A big rectangle should now be on your screen.  
(A big rectangle should remain on your screen  
as the border of your drawing. See Figure 1.1.)

 • Try this several times until you can easily draw  
a box of any desired shape you want.

 • Note the rectangle icon shown on the side of the  
previous page. The icon accomplishes the same thing  
as picking the command from the pull-down menu.  

 • When you feel comfortable with the Rectangle  
command, move on to the next step.

 • Let’s clean our screen by erasing unwanted rectangles. 
The erase procedure will start with the next step.

9. select the Modify menu by highlighting and clicking 
 the left mouse button.
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10. pick the erase command or pick the 
 pencil eraser icon shown on the left 
 side of the screen. 

 • A small square box appears. (The small box is your 
selection cursor.)

11. place the small box on a rectangle outline and click.
  
 • The lines of the box become dashed.

 • Tap the enter key.

 • The selected box disappears.

12. clear the screen of all unwanted boxes.
  
 • When the screen contains only one rectangle large 

enough to form the border as shown in Figure 1.1,  
we’re ready to return to drawing.

13. The Spline command will be used to create the shape of 
 the funny face. pick insert (from the pulldown menu), 
 then the spline command. 
 (Or pick the Spline icon 
 on the Draw 2D toolbar.)

 • The Spline command should now be displayed in the 
command prompt area. 

14. Move the cursor to the top-middle of the rectangle.
 
 • The Spline command is active and you are ready  

to pick a start point.

15. click the mouse button in the shape of a diamond and 
 watch a curve form as you pick each point.

16. When you are only one pick away from forming an 
 irregular circle, type “c” at the command prompt 
 (bottom of the screen.) This will close the irregular 
 circle by bringing the end point back to the starting point. 
 To terminate the spline command (after closing), 
 right click. 

 • The Spline command can sometimes be difficult  
to control or terminate; practice closing and  
terminating splines. 

 • Practice forming irregular shapes until you can  
control the size, shape, and contour as desired.

17. To clear your screen of unwanted contours, 
 pick the Modify menu, then erase or pick 
 the eraser icon on the Modify toolbar.
  
18. Move the cursor to a curve you wish to erase.
  
 • A small box appears.

19. position the small box on the item to be erased, then click. 

 • The item becomes dashed.

 • Tap the enter key to delete the unwanted spline.

 • Practice erasing items until you have rid your screen of 
all unwanted items.

 • If you erase an item in error, pick the edit menu, then 
pick Undo erase. 

HELPFUL HINT

Each time the Undo command is used, A+CAD 2008 
backs up in its memory of the drawing, and so the erased 
item reappears. If you back up too far, you can reverse 
things with the Redo command. It is wise to not undo 
more than one command at a time. Redo is under the Edit 
menu, or can be activated by the right-facing arrow icon 
on the toolbar.

Now that our screen is cleared of unwanted items, let’s continue 
our happy face by adding eyes. (See Figure 1.1.)

20. pick the insert menu.

21. pick circle, then 3 points.  Or, you may 
 use the circle icon on the Draw 2D toolbar.

 • This selection will require that you pick three points 
before the circle will be complete.
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 • Try drawing circles by specifying a radius and/or  
diameter size. You should practice drawing circles  
using various methods before you continue on. 

22. position the pointer where the left eye should go.

23. pick two points with the cursor, then drag the circle 
 outward until you have obtained the desired size, then click.

 • One of the desirable aspects of drawing with software  
is that once an object is drawn, it can be copied rather 
than redrawn.

24. pick the Modify menu.

25. pick copy (or pick the Copy icon from the 
 Modify toolbar). 

26. place the small select box on the edge of the eye 
 (circle), and click.

 • When the circle becomes dashed, tap the enter key.
 
 • The machine now asks you to specify a “basepoint.” In 

layman’s language, this means “where you want to move 
the circle from,” e.g. the top, bottom, center, etc.

27. pick the bottom edge of the circle with the small select box.

 • The circle changes from a dashed to a solid line as you 
drag it to the right. 

28. Move the circle to the right to form a right eye and click.

 • You should now have a face and two eyes.

 • Now lets create a mouth by using the Arc command.

29. pick insert.

30. pick arc, then 3 points.  (The Arc icon on the 
 Draw 2D  toolbar automatically selects the 
 3 point option.)

31. position the cursor (or pointer) where the left corner 
 of the mouth should go and click.

32. pull the cursor down and to the right to form the 
 bottom of the mouth and click.

 • A straight line will show until the bottom  
point is picked.

33. Move the cursor upwards and to the right to form 
 the right corner of the mouth, then click. 
  
 • An arc has been created.

 • Did you notice that the line bent after you picked the 
bottom point of the mouth and you moved your cursor 
upward to form the right corner of the mouth?

 
34. Practice drawing arcs until you can form an arc to the 
 desired shape.

Now let’s add our name and identification number to the drawing.
We will do that through the use of the Text command.

35. pick the insert menu, then Text. (Alternatively, 
 pick the Text icon from the Draw 2D toolbar.)

36. position the pointer anywhere to the right of the face 
 and click.

 • This is where you will begin to write the word SMILE.

 • The command prompt now asks you for the height of the 
letters you want. Pick a desired height or simply tap the 
Enter key for the default setting.

 • The software  now asks you for a rotation angle. Just tap 
the Enter key to accept “no” rotation.

37. Type “ sMiLe” just as you would on a typewriter.

 • Be sure to tap the enter key twice when you have  
finished typing.

 • If the text you have entered looks the way you want it to, 
but it is too small, you could enlarge the text by scaling 
it larger. If you wish to try scaling, (text or any drawn 
object) follow the next few steps.
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38. pick the Modify menu, then scale --- or 
 pick the Scale icon on the Modify toolbar.

39. put the pointer on the word and click.

 • The text becomes shaded.

 • Tap the Enter key to confirm that the selected  
item is what you want to scale.

40. When requested for the basepoint, put the crosshairs 
 at the lower left corner of your text and pick.

 • Your text will begin to enlarge as you move the  
cursor to the right.

41.  click when your text is as large as you wish for it to become.

 • Enlarge your student identification # until it is  
the size you desire.

 • If you are pleased with the size and location of the big 
box around your drawing, create a second and third box 
to contain your name and student identification number. 
(See drawing 1, Figure 1.1)

42. Using the text commands illustrated in steps 35 through 37, 
 complete the drawing so that it looks like Figure 1.1.

SAVING DRAWINGS

Objective: This exercise will familiarize you with the commands 
Save and Save As. under the File menu.

1. Pick the file menu.

 • A pull-down screen appears.

CONCEPT

As you create them, drawings are stored in memory. 
Whatever is in memory is lost when the computer is 
turned off or when Windows crashes. To avoid this loss, 
your work should be saved every 10-15 minutes to protect 
against data loss from power outages or other problems. 
A+CAD does this automatically for you.

2. Click on the save command

 • The save drawing as Dialogue box appears.  
(see figure 1.2)

Figure 1.2

 • Select an appropriate folder by clicking on the  
down arrow in the “Save in” box. 

 • The file name should now be given. (Note the middle 
area of the dialog box.)

 • Position the pointer in the box to the right of  
file name and click.

3 Type: DRAW1

 • This names your file as DRAW1.DWG

 • The software automatically adds the .DWG file exten-
sion. You do not need to add the file extension as a part 
of the name.

4 pick the save button.

 • The file is now being saved to the hard drive  
in your computer.
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 • Some computers have a light to indicate hard drive  
activity, so you can see the system placing what is  
on your screen into the drive.

 • Once you have used Save As and assigned a name to 
your drawing, you can use a quicker and simpler system 
of saving your file onto the drive. This command is 
Save. Let’s resave our first drawing by using the  
Save command.

5.  pick file menu again.

6. Pick save again.

 • No questions are asked. Your machine immediately 
proceeds to saving the file.

 • Each time you save a file, the software overwrites previ-
ously saved data and adds unsaved new information. 
The previous version is given the extension of .bak.

saViNG dRaWiNGs UNdeR aNoTheR NaMe 

CONCEPT

There are times when you want to save a drawing with 
the changes you have made, but you  would also like to 
keep the original. To do this you use the Save As com-
mand. This is done exactly as the as you did the first 
“Save As.” Follow the instructions below to save your 
drawing to another name.

1. pick file menu.

2. Pick save as.

 • The “Save Drawing As” dialog box reappears showing 
the name that the file is currently being saved as.

3. position the pointer in the box to the right of 
 Draw1 and pick.

 • The highlighting disappears.

 • You may now begin to type.

4. Type: DRAW1B

 • This saves the drawing to your disk and  
names it DRAW1B

5. Move the pointer to saVe, then click.

 • Your file is now being saved.

 • Your first file is saved as DRAW1 on the disk. Your 
second file is saved as DRAW1B on the disk. You could 
now make changes on DRAW1B without affecting the 
information saved as DRAW1. You now have two  
separate drawing files.

6. start a new drawing by using the New command under 
 the file menu.

ReTRieViNG fiLes

Objective: This exercise will familiarize you with the Open com-
mand under the File menu.

CONCEPT

If you are starting a new session and need to work on  
a drawing you have already started, you will need to  
retrieve that file. The following instructions will show  
you how to retrieve a file.

1. select the File menu.

 • If you have trouble selecting commands in this menu, 
return to the previous section until you can select a 
menu and command without any trouble.

 • The File menu appears, showing the commands  
that can be selected in this category.

2. select Open.

 • A dialog box (Open Drawing) appears in the middle  
of the screen (see Figure 1.3.)
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3. Pick the down arrow to the right of the “Look in” droplist 
 until you have selected the folder in which files are stored.
 • See Figure 1.3

    

Figure 1.3

 • The dialog box shows names of drawings that already 
exist on your computer’s drivee.

 • The computer is displaying the drawings that are  
saved in the current folder, as named by Look In.

4. double click on the name of the desired drawing.

 • The selected drawing now appears on the screen.
 

HELPFUL HINT

If many files exist on the folder, it may be necessary for 
you to move the slider bar at the bottom of the drawing 
listing. To move the slider bar, position the pointer on the 
slider bar and move it to the right while the pick button is 
depressed. Move the slider bar approximately 1/4th inch 
to the right and watch the names move to display new 
files. You may continue to move the box to the right until 
no more names are displayed.

 

• Try opening several files until you are comfortable  
with this command.

pRiNTiNG (pLoTTiNG) fiLes

Objective: This lesson will familiarize you with the Plot command 
under the File menu. 

Making a hard copy (printing) from A+CAD 2008 has 
become more difficult due to the many options that have 
incorporated to satisfy the varied needs of customers. The 
method shown below is only ONE way to make a print. 
It is relatively simple and does not incorporate other con-
cepts at this time. Additional methods will be described in 
following chapters.

 

Before you begin the printing process, you will want to have the 
drawing of your smiling face on the screen, and you must make 
sure the printer is turned on with plenty of paper.

1. select the file pulldown menu.

2. select print setup.
 
• A Print  Setup dialogue box appears (see figure 1.4).

Figure 1.4
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3. Using the down arrow at the right of the word 
 “Name,” select the appropriate printer for your location. 
 (Your instructor should have your machine hooked to the 
 appropriate printer so that all you need to do is check to 
 see that the proper name is displayed in this window.)

4. Change orientation to Landscape.

5. Click oK.

6. From the file menu, select print. 

 • A Print  Setup dialogue box appears (see figure 1.5).

Figure 1.5

7. Click the advanced tab, and then set the print  style Table 
 (pen assignments) to icad.ctb.

 • Pick No when asked if you want to assign this  
Print Style Table to all layouts.

8. Click the small box next to center on page.

 • The dialog box should now look like Figure 1.5.

9. Pick the scale/View tab.

Figure 1.6

10. pick the settings to match the Print dialog box shown 
 in Figure 1.6; then pick apply

11. pick print preview.

 • A display of your drawing will be shown in a window. 
It is a good illustration of how your drawing will be 
located on the paper.

12. pick print.

 • A drawing that appears the same as the preview should 
now be printed.

 • A completed/printed drawing should appear in your 
printer basket in one or two minutes.
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chapTeR oNe assiGNMeNT

Make sure your drawing contains your name and student identi-
fication number; turn it in for grading. Use the Text command to 
enter this data, as shown in Figure 1.1.

Review Chapter 1. You should have MASTERED the following 
terms and activities before proceeding:

 • Using a mouse.
 • Selecting menu categories
 • Drawing curves with the Spline command.
 • Clearing the screen for a new drawing (New command)
 • Drawing a three point arc (Arc command)
 • Drawing a circle (Circle command)
 • Entering a single line text (Text command)
 • Saving a file (Save and SaveAs commands)
 • Printing drawing files (Plot command)
 • Retrieving a file (Open command)
 • Drawing a square or rectangle (Rectangle command)
 • Erasing an unwanted item (Erase command)
 • Be able to copy one or more items to avoid  

redrawing anything (Copy command)
 • Be able to change the size of object larger or  

smaller (Scale command)

If you have not MASTERED the above items, go back to the 
begin¬ning of Chapter One and repeat the exercises as necessary. 
These skills are basic to your success.

ReMeMbeR! Repetition is the key to MASTERING learning.
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chapTeR TWo

dRaWiNG # 2 – polyline and assists

dRaWiNG # 2 - seT Up

Objective: This exercise will familiarize you with the commands 
Snap and Grid and how to use these menu items as tools in set-
ting up a drawing area to obtain accuracy. 

CONCEPT

With A+CAD you can use snap and grid to place objects 
accurately on your drawing. When snap is on, A+CAD 
will align the coordinates of any point, line, circle, or 
other entity to the nearest point on the snap grid. Snap de-
fines the smallest increments that A+CAD will recognize 
when you move the pointer.

If you are just starting a session, perform the necessary startup 
procedures for A+CAD.

1. pick settings, then drawing settings.

 • A dialog box with several tabs appears. 

2. pick the coordinate input tab, and then select snap and 
 Grid from the change settings for droplist. 

 • The numerical values in the dialog box can be changed 
by picking to the right of the values shown and re-enter-
ing the desired data after “backspacing” to remove the 
existing data. 

• See figure 2.1

3. Turn on Snap by clicking the small box. If necessary, 
 change the snap spacing to 0.5.

 • The Snap option tells the software to lock on to the  
nearest value. For example, if you set the snap to 0.5,  
the software will lock your work to the nearest 0.5  
value whenever you draw a line. 

 • Usually grid marks are set to the same value as  
snap settings.

4. You can now turn on the Show Grid option; ensure 
 the desired size of the grid points is 0.5.

 • The X setting is for determining the spacing for horizon 
grid marks. The Y value determines the spacing in the 
vertical direction.

  
 • Grid spacing is usually set equally, but may vary  

according to the need.

Figure 2.1

 • Note that the Grid Spacing for both X and Y has  
been set to .5. 

  
5. Pick OK at the bottom of the dialog box.

 • This clears the screen of the dialog box and the values 
for the snap and grid have been established.

 
6. Now select the Line command and draw 
 numerous lines.

 • Notice how each line snaps to the closest grid dot.

 • The Snap/Grid commands allow you to draw  
gap-free lines. 

 • The Snap and Grid functions can be locked  
together or used independently.



13

basics of a+cad

7. Reactivate the drawing settings dialog box. 

8. delete the existing snap values and type .25.

 • This establishes a snap value half way between  
each grid mark.

9. click oK.

10. select the Line command and draw lines mid-way 
 between the grid marks.

 • Notice you can draw from grid mark to grid mark...or 
half way between the grid marks.

sNap and GRid settings may be turned on and off as desired. 
If a drawing requires entities to be located at positions other than 
that established by the snap/Grid settings, you can turn them off 
by double-clicking the word SNAP and GRID at the very bottom 
of your monitor screen. “Double-click” means to click the left 
mouse button twice, quickly. (When the button is grayed out, the 
command is inactive. When the word is black, the command is 
active or functioning.)

11. double-click the sNap button.

 • The grid continues to display, but drawing functions  
are no longer locked to the displayed grid.

12. Test the Line command without the grid.

13. Test the Line command with the grid displayed but snap off.

When you are comfortable with the drafting aids of Snap and 
Grid, proceed to the next section where you create the border for 
the drawing..

dRaWiNG #2 - The boRdeR

Objective: This exercise will utilize commands used in the first 
drawing and familiarize you with the Polyline command under 
the Insert menu. Note the width of the borderlines on “Draw 2” 
shown below.

Each new step necessary to construct the drawing is given in this 
exercise. Follow each step carefully and watch how your com-
puter responds to the different commands.

Figure 2.2 shows how your border should look when complete.

 

Figure 2.2

1. Select the Insert menu.

 • Remember, to select a function, you must click the left 
mouse button on the name of the function you want.

2. select Polyline.

 • The command prompt at the lower left corner of  
your screen will have the prompt “Polyline, Start  
of polyline:”. 

3. position the pointer two grid marks down from the top of 
 your screen, and two grid marks from the left, then click.

 • This starts the beginning of your border line  
using a polyline. 

 • You may now add width to your polyline by  
entering a W. (Then tap the Enter key.)

 • The software is now requesting the width of the polyline 
at the start point. Type .05 and tap the Enter key. The 
machine will now request the width for the end of the 
line. Type .05 and tap the Enter key.

4. position the pointer two grid marks down from the top of 
 your screen, and two grid marks from the right; click the 
 left mouse button.
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 • Make sure your snap setting is correct and turned on.

 • You now have a line across the top of your page and are 
ready to continue making a rectangular border.

 • If there is an error in location, you can terminate the 
command by tapping the ESCape key and starting over 
--- or you can erase the beginnings of the rectangle by 
using the erase command as you did in the first drawing. 

 
 5. Now position the pointer in the lower right hand corner of 
 your grid area. When you are two grid marks up from the 
 bottom and two to the left of the right edge of the grid area, 
 click. (14 grid marks down)

 6. continue to draw a rectangle by picking an appropriate 
 lower left corner. 

 • To return to your starting point, you should type C to 
close the rectangle. (As always, you must tap the Enter 
key after typing the letter C to make the machine recog-
nize what you have entered into the keyboard.)  
If you return to the starting point by picking, your 
polyline will have a square or “non-joined” corner. Try 
drawing several small rectangles and finish by closing 
and by picking until you see the effects of each.

 • If there is an error in the location of your rectangle, 
ERASE the rectangle and redraw it. 

7. continue to draw the title box using the .05-wide Polyline 
 command until it looks like Figure 2.2 or “Draw-2” at the 
 end of the chapter.

8. Complete the text for the title box using the Text command. 
 (Refer to Chapter 1 if necessary.)

drawing #3, The obJecT

1. Begin to draw the object shown in “Draw 2” by picking 
 insert, then Line, or by picking the Line icon. 
 
2. position the cursor at the “Start Point” as shown in “Draw 
 2.” See Figure 2.3. (Pick a point on your screen that is about 
 the same location as the start point shown in the drawing.)

 

Figure 2.3

3. Move the cursor 5 grid dots down and pick. (Note the 
 command prompt is asking you for the second or end 
 point of the line.)

4. To draw the long horizontal line on the bottom, count 10 
 grid spaces to the left and pick. 

5. continue with the Line command, and draw the slanted line 
 as shown. Move clockwise around the drawing until you 
 come to the X. Count the grid marks as you go so your 
 drawing comes out as shown.

6. select insert, then circle or use the Circle icon. 
 (Use the “center, radius” option.)

 • The lower left corner of your screen will have  
the prompt “Circle, Center Point.”

7. position the pointer 2 grid marks down from the top of the 
 tab and two spaces from the left of the tab, and pick.

 • The lower left corner of your screen will now prompt 
you for the radius of the circle.

 • The command prompt defaults to the radius setting  
unless you select “diameter.”
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8. drag the cursor one grid mark to the right and pick. 
 (This determines the radius value.)

 • A circle is drawn with a diameter of one.

9. select the Modify menu and pick copy, 
 or pick the Copy icon.

 • The lower left corner of your screen will prompt  
you to select the items you want to duplicate.

10. position your pointer so that a window is created 
 around the entire tab and pick. (The second pick 
 completes the window.) 

 • (The window should include the vertical line that  
begins the tab and includes the last line drawn.)

 • Be sure to tap the Enter key to confirm that you  
want the dashed items to be copied.

 • The prompt line will now ask you to pick a reference 
point to be used while copying the selected items. 
(“Multiple/Vector/<Base point>:”)

11. pick the point marked with a black dot.

 • The prompt line will now ask you where you  
want to move the items that are to be copied.  
(“Displacement point:”) 

12. drag the copy of the first tab to the right and pick 
 the end of the last line drawn.

 • A second tab now has been drawn and completes  
the drawing as illustrated.

13. save this drawing as dRaW3, but do not plot it at this time. 

 • This drawing should be submitted after you have  
dimensioned it. Dimensioning is explained in Chapter 4. 

 • Grid marks are not plottable! Grid marks are for  
construction use only, you cannot plot them.
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CHAPTER 2 ASSIGNMENT 

Using the Text command, make sure your name, personal identi-
fication number, and drawing 2 is entered on your drawing. (The 
drawing you submit should look identical to Draw-2 on figure 
2.3.) You will be asked to open this drawing in Chapter 4 when 
you must accurately dimension it.

Review Chapter 2. You should have a basic understanding of the 
following terms and actions before proceeding:

 • Grid: setting up a grid to specific values.
 • Snap: setting up snap increments to match a grid.
 • Turning on the grid & snap by using both the  

dialog box and the word switches located below  
the command prompt line.

 • Circle: drawing a circle.
 • Line: the drawing of individual lines and  

connected lines.
 • Polyline: drawing lines that are continuously  

connected, and drawing lines of various widths.

Go back to the beginning and repeat the commands used in the 
drawing until you can use them without referring to the book. 
Work until you can create the drawing quickly without any  
directions from the textbook. 

Remember, practice makes perfect
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chapTeR ThRee

eNTiTY sNap Modes

We should dimension our drawing to check its accuracy. and to 
allow others to readily see the size of the object. At this time, 
however, we have no way to accurately return to the corners of 
the drawing other than trying to set the Snap and Grid so that the 
corners (intersections) match the settings. The entity snap settings 
(esnaps) allow us to grab a corners, end points, midpoints, and so 
on with absolute precision. (Some CAD systems call this feature 
osnap or object snap. “Entity” is another name for “object.”)

Learning to use esnaps is a very major item. It is nearly impossi-
ble to create accurate drawings of any type without using esnaps. 
each and every drawing you make from this point on require 
that you use esnaps. You will not be directed to use them for 
each step, but you will not be able to use a computer for drafting 
until you become very familiar with them. Now, let’s try to use 
them in preparation for dimensioning “Draw2.” 

1. If “Draw2” is not on your screen, open it.

2. Now right-click the esNap button that is just 
 below the command prompt area.

 • A small menu appears on your screen.

3. Left-click on settings.

 • The same Drawing Settings dialog box that we used  
to set Snap and Grid appears, except that it is now  
displaying options for entity snaps. See Figure 3.1.

 • Some of the Entity Snap terms are self explanatory, 
however a listing of each term is listed below.

  Endpoint grabs the very endpoint of a line

  Nearest grabs an entity at any location closest  
 to the cursor. (You cannot pick into  
 space close to an entity.)

 Perpendicular  draw a line perpendicular to another  
 line, arc, circle, etc.

 Quadrant finds one of four divisions of a circle

Insertion  snaps to the insertion point of a block, 
   shape, text string or attribute

Center  grabs the very center of an arc 
   or circle

Midpoint grabs the very middle of a line or arc

Point  grabs a point. (Points are not covered  
 in this book.)

Tangent  allows you to draw a line that touches  
 the edge (circumference) of a circle.

Intersection finds the crossing point for two or  
 more lines or other objects

Apparent finds the implied intersection of two  
 lines. (Cross your index fingers at 90  
 degrees holding one about an inch  
 above the other. An Apparent 

   Intersection exits where the two 
   fingers appear to cross.) 

Figure 3.1

5. pick the endpoint box. 

 • A checkmark appears in the box telling us that when the 
cursor is placed near the end of a line, a small square 
will appear indicating the perfect end of a line.
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6. pick oK.

 • The dialog box goes away and we are ready to  
experiment with our drawing.

7. check the sNap and GRid buttons beneath the Command 
 Prompt to make sure both are turned off.

8. activate the Line command or pick the Line icon.

9. place your cursor on the bottom line and watch it 
 snap to one of the ends.

 • The small yellow box and yellow tooltip “Endpoint” 
tell you that the software has found the perfect endpoint 
of your line, and is ready to begin a new line from the 
endpoint it has just found.

10. cancel the command by pressing the ESC key.

11. experiment several times with the Endpoint esnap 
 to make sure you understand how it is working.

12. Right click the esNap tab below the command prompt and 
reactivate the Drawing Settings dialog box.

13. activate the Midpoint and center settings.

14. close the drawing settings dialog box, and then see if you 
 can draw a line from the midpoint of any line in Draw2 -- or 
 from the center of your circles.

15. Your drawing contains endpoints, intersections, midpoints, 
 quadrants, and centers. See if you can draw a line from 
 anyone of these locations.

16. Erase all unwanted lines so that you drawing looks like 
 Draw2 in the previous chapter. We will now get ready to 
 dimension Draw2.
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chapTeR foUR -- diMeNsioNiNG

paRT i ---diMeNsioNiNG WiTh defaULT seTTiNGs

In this chapter we wish to use the dimensioning commands to 
check the accuracy of our drawing and add size information to 
it. To do that, we will use the “default” settings. Default set-
tings means that we use the numbers, sizes, and format that the 
software is preset with as it comes from the factory. Because of 
the varied needs of so many customers, the software has many 
options for dimensioning and has become quite complex. In 
this chapter we will learn how to dimension using the simplest 
settings possible. We will learn to set our software to specific 
requirements in Chapter Eleven.

Dimensioning is basically a three step process. We must first 
select the endpoint on the left side of a line, then the endpoint on 
the right side, and finally pick the location where the dimension 
line should be placed.

To test the dimensioning procedure, we must first reopen our 
previous drawing; the drawing that you drew in chapter 
four (draw-3). If you are continuing on, and Draw-3 is on your 
screen, you are all set and ready to go.

Let’s begin to dimension

1. Make sure the Dimension toolbar is visible. If it is not, 
 pick the pull down “View,” then Toolbars. 

 • The Select Toolbars dialog box appears.

2.  Pick the “dimension” box.

3. close the select Toolbar dialog box and slide the toolbar 
 (shown below) to the top or side of your screen.

 • The Dimension toolbar appear on your screen.  
See Figure4.1.

Figure 4.1

 • Remember to pick and hold the blue titlebar to  
move the toolbar.

4. Pick the insert menu, then dimension, and 
 then Linear, or simply pick the Linear icon.

5. depress (double-click) the esNap button beneath the 
 command prompt to activate the entity snap settings.

 • The snap and grid functions should be turned off.

6. Dimension the bottom of your drawing by picking the 
 lower left corner of your drawing.

 • Your esnap tooltip should identify the very left corner  
of your drawing. Pick when Endpoint shows the end  
of the line.

 • The software now asks you to identify the end (right 
side) of the drawing. Pick when the endpoint box  
shows at the end of the line.

 • After picking the lower right corner of your drawing,  
the software asks you to identify where you want the 
dimension line to be placed.

7. drag your dimension down approximately one inch 
 below the drawing and pick.

 • A properly drawn dimension of 7.0000 should show. 
(Note Figure 4.2)

8. Let’s see if we can show the horizontal distance of the 
 angled line at the bottom of the drawing.

 • The horizontal distance between the two end points of 
the angled line will be smaller than the true line length 
we will measure in a different manner.

9. Tap the enter key.

 • This will reactivate the linear dimension command.
 
10. pick both ends of the angled line and drag the dimension 
 approximately one-half inch below the drawing.

• A dimension of 2.0000 should now show. 



20

basics of a+cad

11. The linear dimensioning command will dimension vertically 
 as well as horizontally. Let’s measure the height of the 
 drawing by picking the lower right corner of the drawing, 
 then the top of the vertical line. 

 • A dimension of 2.5000 should show. 

 • Your monitor should now show a drawing like  
the one shown below.

  

Figure 4.2

Now, if you have the concept of “linear” dimensions, let’s go to 
“aligned” dimensions and see what the true length of the angled 
line is.

12. pick insert, dimension, and then aligned, 
 or you can use the Aligned icon. 

13. Pick the left corner of the angled line.

 • Make sure your ESNAP button is activated and  
set to endpoint.

14. pick the right corner of the angled line.

15. drag the dimension line inside the drawing approximately 
 one-half inch and click.

 • You should now have a dimension showing the true 
length of the line, (2.0616 units) Note Figure 4.3.

 • Aligned dimensions can be placed at any angle, and  
they are always parallel to the line measured.

 • Measure some other angled distances until you are  
comfortable using the “aligned dimension” command.

  

Figure 4.3

If you are comfortable with aligned dimensions, let’s use the 
“continue” dimension command to make dimensioning easy 
across the top of the drawing. Note Figure 4.4.

 

Figure 4.4

To begin the sequence of dimensions across the top, we’ll use the 
“linear” dimension command for the first dimension.

16. pick the top left corner of the drawing,

17. pick the upper left corner of the tab.

18. Locate the dimension approximately one-half inch 
 higher than the left tab.

 • A typical linear dimension showing 1.000 should  
appear on your screen.
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To quickly add each of the remaining dimensions, we will 
now use the “continue” dimension command. 

19. pick insert, dimension, and then 
 continue, (or use the Continue icon.)

20. pick the top of the vertical line on the first tab and 
 watch the machine enter the second dimension.

 • A value of 2.0000 should now show.

21. pick each of the corresponding points shown in Figure 4.4 
 and watch the machine dimension each area for you.

 • Note that the dimensions are perfectly aligned.

paRT ii --- diMeNsioNiNG WiTh pRecisioN

Our drawing is sufficiently dimensioned for this exercise, howev-
er the precision setting of four decimal places is quite excessive 
for such a simple drawing. We will now learn how to reduce our 
precision to a more logical scale. (And we will learn to set up the 
A+CAD software for a drawing the way a CAD system should be 
set for each drawing!) 

1. pick settings and then dimension settings.

 • A Dimension Settings dialog box appears.  
See Figure 4.5 below.

2. pick New

 • A “Create New Dimension Style” dialog box appears. 
See Figure 4.6. 

Figure 4.5

3. enter a name for the new style you will be creating. 

 • A good suggestion would be to enter the name of the 
drawing, plus adding xx. The xx represents the accuracy 
setting of two digits to the right of the decimal place. 
(Type in Draw2xx.) See Figure 4.6.

 

Figure 4.6

 • Giving a new name in the New Dimension Style dialog 
box creates a duplicate of all dimension settings. This 
copy is created so that you can make customizations to 
the dimension characteristics that you want to change 
without changing the original settings that come from 
the factory --- which could create dimensioning prob-
lems for the next machine user --- or for you as you 
proceed on.

3. pick Create.

 • The Dimension Settings dialog box returns.  
See Figure 4.5.

4. pick the Units tab to display the Linear Dimension settings.

5. pick the down arrow in the Decimal Places box 
 until “2” appears.

 • This setting will give dimension values displayed with 
two decimal places to the right of the whole number.

 • The preview illustration in the dialog box changes to 
show you what your drawing will look like when you 
make changes to the dimension style. accuracy. (Select 
different accuracy settings and watch the dialog box 
change each time you select a different setting.)

6. pick the save button at the top of the Dimension 
 Settings dialog box.
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 • Your style with appropriate modifications will  
now be operating instead of the Standard settings  
that originally existed.

7.  pick oK.

 • All of your dimensions now change to  
two-point accuracy.

  
 • If your dimensions fail to change to two-point accuracy, 

follow the next few steps.
 
  a. Pick dimension
  b. Pick Update
  c.  Select the dimensions that did not update. 
  All numbers should now change to two point accuracy.

8. Make sure that your name etc. is entered into the titlebox 
 area you created as a part of the drawing. Save your drawing 
 as Draw4. When you are complete, submit your drawing for 
 grading. If you need help in plotting, refer back to Chapter 2.

If you have any questions regarding the use of the Dimension 
Style Manager dialog box, experiment over and over until you are 
comfortable with this procedure. Advanced uses of the manager 
dialog box will follow in additional chapters, so it is very impor-
tant that you understand what has occurred so far.
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CHAPTER FIVE

ABSOLUTE COORDINATES

Each new step necessary to construct the drawing shown at the 
end of this chapter is in this exercise. (Commands and procedures 
covered in earlier chapters will not be repeated --- you should 
have mastered those already.) Follow each step carefully and 
watch how your computer responds to the different commands 
you give it.

For this lesson you will be using the Insert and Modify  
menus again.

In the previous chapter you drew a line by clicking the left 
mouse button on the starting point and then the ending point. The 
method used was ultra simple and somewhat crude. (Remember 
when we counted grid marks to get a starting point for drawing 
two?) This lesson teaches you how to locate precise points that 
are based upon the logic of how all graphic points are found, 
used, and retained by the computer. We will be learning to use 
Absolute Coordinates, and how to draw lines by specifying actual 
coordinates (beginning and ending points) for the line through the 
keyboard.

If you are just starting a session, perform the necessary start up 
procedures for A+CAD so that the menu listings are across the 
top of the screen.

Absolute Coordinates are values that designate a specific 
location on the drawing based on the lower left corner of 
the screen being 0,0 (the origin). When the grid is turned 
on, the bottom left corner represents the origin of the 
drawing, or 0,0. As you move the cursor (horizontally) 
you are moving in the X direction. As you move the cur-
sor vertically, you are moving in the Y direction. Coordi-
nate values represent distances away from the origin; the 
X value is always shown first. For illustration purposes, 
the data in Figure 5.1 has been moved towards the center 
of the screen. The figure however, shows the manner in 
which all data is laid out and organized. Notice the inter-
section of  X and Y is 0,0.

 

 

Figure 5.1

A full size drawing of our first object drawn with 
absolute coordinates” is shown in Figure 5.2.

 

Figure 5.2

Drawing Lines Using Absolute Coordinates

1. select TooLs, then dRafTiNG seTTiNGs.

 • Set your Grid value to 1 and turn on.

 • If you are unable to execute these commands,  
refer back to Chapter 4.
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2. select LiNe.

 • The dialog box should now be cleared from the screen 
and the prompt “Line - from point:” will be in the com-
mand prompt area.

3. position the pointer towards the center of the screen, 
 but DO NOT CLICK THE LEFT MOUSE BUTTON.

 • You will now enter the coordinates for the starting  
point of your line.

 • We will begin the drawing shown in Figure 5.2 by  
starting in the upper left hand corner.

4. Type: 3,6 then Tap the eNTeR Key.

 • The system only recognizes coordinates input  
through the Enter Key.

  
 • These coordinates mark the beginning of the line.
  

HELPFUL HINT

These coordinates use the Cartesian XY system. The 
first coordi¬nate is 3 units to the right of the origin along 
the X axis. The second coordinate is 6 units up from the 
origin along the Y axis. Where these two lines intersect is 
your set of coordinates. (See Figure 5.2).

 • You will now type the coordinates for the ending  
point of the first line.

5. Type: 5,6 and tap the eNTeR Key.

 • Notice that the first horizontal line is drawn between  
the coordinates you specified (see Figure 5.2).

 
6. Type 5,5 and tap the enter key.

 • Notice that the second line (vertical) connects to the  
first and is drawn between the coordinates you specified 
(see Figure 5..3).

 • You will now enter the coordinates for the ending  
point of the third line.

7. Type: 6,5 and tap the eNTeR Key.

 • You should now have 3 connecting lines on the screen.

8. Continue to enter the values show in Figure 5.2 until your 
 drawing is complete. If you enter a value in error, you may 
 erase the wrong line and re-enter using the correct values.
 
9. save this drawing as dRaW5-outline. 
 (absoLUTe cooRdiNaTes)

 • If you have trouble saving, refer back to Saving  
A Drawing in Chapter 1.

DRAW 6 (ORDINATE DIMENSIONS)

Objective: The next drawing will familiarize you with locating 
circles at precise points based upon absolute coordinate values. 
The dimension values are all based upon the X and Y values of 
0,0 at the lower left corner of the drawing. Such a measuring 
system would be needed and valued when laying out a template 
for a machine to make or cut out.

drawing objects and circles with absolute coordinates

1. Draw the object shown in Figure 5.5 using the coordinate 
 values specified for each of the six corners. 

 
 • If you have trouble remembering how to draw lines 
  using absolute coordinates, refer back to the beginning 
  of the chapter.

2. Draw the circle in the upper left corner of the drawing by 
 specifying the center point location as 4.205,3.050 when the 
 machine requests the center point of the circle. Figure 5.3 
 (below) shows the Command Prompt after the circle com
 mand has been requested, and what your response should be.
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Figure 5.3

3. Each circle should be entered using the coordinate values 
 shown on the “Circle Locations” drawing shown at the end 
 of this chapter.

• Figure 5.4 shows the drawing with all of the circles entered.

 
 

Figure 5.4

After all of the circles are entered, the drawing should be di-
mensioned using the ordinate dimension command. Ordinate 
dimensions measure the perpendicular distance from an origin 
point (called the datum) to a dimensioned feature, such as the 
circles used in this example. Ordinate dimensions show the X 
or Y value with a leader line. Ordinate dimensions measure the 
distance of a point along the X or Y axis. While the datum point 
can be changed, in this example, 0,0 remains in the corner of the 
drawing and the entire drawing is measured relative to the abso-
lute values of 0,0. Using the Ordinate Dimension command, we 
dimension the upper left corner of the object first.

4. Pick insert, dimension, ordinate, and the intersection 
 of the upper left corner of the object. 

 • The command prompt asks if you want specific infor-
mation regarding the X datum, Y, datum, etc. You may 
respond with a specific directive or you may allow the 
software to use the automatic feature and provide you 
with either X Y information depending upon how you 
move your mouse.

 • Move your mouse to the left of the intersection and the 
software provides the distance that the point is along 
the Y axis or datum. If you move your mouse below the 
intersection you will see that the software measures the 
distance from 0,0 along the X axis or datum.

 5. With the Ortho button activated, drag your cursor approxi
 mately 3/4th inch to the left of the top left intersection and 
 pick. The machine should record 4.500 showing the distance 
 the point is above 0,0. (The 4.5 distance is along the Y axis.)
 
6. Reactivate the Ordinate dimension command by tapping the 
 enter key, and pick the same upper left corner of the object. 
 Now drag your cursor above the intersection and note that 
 the software measures the distance the corner is to the 
 right of 0,0. 

 • The software should now show the distance is 2.5 units 
along the X axis or datum.

7. With the ORTHO button activated, drag your cursor 
 approximately 3/4th inch above the intersection and pick. 
 The software should now record 2.500, showing the value 
 that the intersection is to the right of 0,0. (The value is 
 measured along the X datum.)

8. Finish dimensioning each circle and each corner of the object 
 until your drawing looks like Figure 5.5 below.

 • Positioning the dimensions 3/4th of an inch away from 
the object is easier said than done. If a construction line 
is drawn 3/4th away from the object, then you can drag 
your cursor to the line and align the dimensions. Without 
a line to guide you, your dimensions will be irregular 
and look very unprofessional.

 • Erase the construction line after all dimensions  
have been entered.

 

Figure 5.5
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9. Add a title box with your name and date.

10. Save the drawing as DRAW6 (or Ordinate Dimensions.)

11. Plot and submit for grading.

DRAWING # 5 ARRAY

 Objective: The next drawing uses absolute coordinate values as 
the basis for learning numerous other commands. In this draw-
ing you learn to use many modify functions. (A modify function 
changes the data that is already drawn on the screen.) The 
modify functions used in this drawing are: mirror, array,  
and extend. 

Each new step necessary to construct the drawing shown at the 
end of this chapter is in this exercise. (Commands and procedures 
covered in earlier chapters will not be repeated --- you should 
have mastered those already.) Follow each step carefully and 
watch how your computer responds to the different commands 
you give it.

For this lesson you will be using the Insert and Modify  
menus again.

In the previous chapter you drew a line by clicking the left  
mouse button on the starting point and then the ending point.  
This lesson teaches you to use actual coordinates for the line 
through the keyboard.

If you are just starting a session, perform the necessary start up 
procedures for A+CAD so that the menu listings are across the 
top of the screen.

1. activate the Line command.

 • You will now be able to enter the coordinates  
for the starting point of your line.

2. Type: 3,4 then tap the enter Key.

 • The system only recognizes coordinates input  
through the Enter key.

 • These coordinates mark the beginning of the line.

 • You will now type the coordinates for the ending  
point of the first line.

 
3. Type: 3,5 then tap the enter key.

 • Notice that the first line is drawn between the  
coordinates you specified 

4. Type: 5,7 then tap the enter key.

 • Notice that the second line connects to the first and is 
drawn between the coordinates you specified.

 • You will now enter the coordinates for the ending  
point of the third line.

5. Type: 6,7 then tap the enter key.

 • You should now have 3 connecting lines on the screen.

Using the Mirror Command

CONCEPT

The mirror command is used to copy objects that have 
been drawn, and then place them in reverse on the  
coordinates you enter.

1. Select the Modify menu. 

2. Select the word Mirror, or simply pick the 
 Mirror icon.  

 • You must now select the items to be mirrored.

3. Position the cursor approximately 1/4 inch below and 
 to the left of the first line drawn; click the left mouse 
 button and enclose the objects with a window.
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4. Tap the Enter key to confirm that you want the three 
 lines mirrored.

5. Pick the grid mark directly above the right end of 
 the top line.

 • This marks the first point of the Mirror line.

6. Pick a grid mark six dots straight down from the first point.
 
 • This marks the second point of the Mirror line. 

 • The command prompt now asks if you wish to  
delete the objects that were selected.

7. Tap the Enter key or enter N to confirm that you do not 
 want to delete the original lines.

 • Your original lines have been mirrored and your screen 
should now look like Figure 5.6.

 

Figure 5.6

 • The first three lines were duplicated into a mirrored ob-
ject from left to right, using the coordinates you entered.

8. Tap the enter key to restore the Mirror command

 • The computer always remembers the last command  
used and reactivates that command when you tap the 
Enter key.

9. position the cursor approximately 1/4 inch below and 
 to the left of the first line drawn, click the left mouse button.

 

• This marks the first point of the window used to select all of 
the lines that have been drawn.

10. drag the pointer upward and to the right to enclose the 
 entire object; click the left mouse button.

 • This marks the ending point of the window used  
to select the objects to Mirror. You should see a  
box surrounding your drawing, until you click  
the left mouse button.

11. Tap the Enter key to confirm that you want to mirror 
 the six lines selected.

12. Pick the first point of the mirror line by picking the end 
 point of the lower left line.

13. pick the second point of the mirror line by picking the end 
 point of the lower right line.

 • The command prompt again asks if you wish to  
delete the original lines. 

 • The default setting recommends a “no” response when 
asked if you wish to delete the old lines. Tapping the 
enter key activates the default setting.

  
14. Tap the enter key.

 • Your octagon is now complete.

15. erase the drawing by using one of the two methods you 
 have learned (New or Erase). Repeat the sections on 
 drawing a line and using the mirror command until 
 you are comfortable with drawing by using absolute 
 coordinates and mirroring objects.

16. save this drawing as dRaW5 (or THE ARRAY)

* If you have trouble saving, refer back to Saving A 
 Drawing in Chapter 3.

You have now learned the Mirror command under the Modify 
menu. Practice this until you feel comfortable with it, then con-
tinue on to the next part.
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continuing on with arc, circle, and array

Objective: This part of the exercise will familiarize you with the 
commands Arc and Array. You will also work more with setting 
the coordinates from the keyboard instead of with the mouse.

For this lesson you will be using the insert, Modify and 
edit menus.

To help you get an idea of what you will be drawing in this chap-
ter, study the second drawing located at the end of the Chapter.

drawing an arc

1. Open the drawing dRaW5 (if it is not already on 
 the screen).

 • If you have trouble doing this, refer back to  
Retrieving A File in Chapter Three.

2. select aRc (3 point) under the insert menu, 
 or simply pick the arc icon. 

 • Notice the prompt, “Arc Start Point: “ in the  
command prompt area. You will now enter the  
starting coordinates for your arc.

3. Type: 5,7 then tap the enter key.

 • This coordinate denotes the arc’s starting point.  
Remember you are using the Cartesian XY coordinate 
system. The first coordinate is 5 to the right of the origin 
on the X axis. The second coordinate is 7 up from the 
origin on the Y axis. Where those two intersect is the 
coordinate 5,7.

4. Type: 6,8 then tap the enter key.

 • This coordinate denotes the midpoint of the arc.
 
5. Type: 7,7 then tap the enter key.

 • This coordinate denotes the ending point of the arc.

 • You should now have an arc attached to the top of  
your drawing.

drawing a circle, Undo and Redo

1. Select ciRcLe under the insert menu, 
 (Center, Radius) or pick the Circle icon.

 • Notice the prompt, “Circle Center Point:,” in the  
lower left hand corner.

2. Type: 6,7.5 then tap the enter key.

 • This coordinate denotes the center point of the circle.

 • The command prompt now requests the radius of  
the circle.

3. Type: .25 then tap the enter key.

 • A small circle is drawn inside of your arc.

 • If you make a mistake and you catch it before you con-
tinue on to anything else, you can use the undo  
command.

4. Select UNdo under the edit menu. 

 • The circle will be gone.

 • If you decide that it was OK, you can put it back  
by using the redo command.

 
5. Select Redo under the edit menu.

 • Notice that the circle has reappeared. Practice this a  
few times until you feel comfortable with the commands 
Undo and Redo.



29

basics of a+cad

creating an array

CONCEPT

A polar array is a command that allows you to duplicate 
and spin (array) selected items around a center point.

1. Select the Modify menu and pick array or simply 
 pick the Array icon.

 • Prompts for the array appear in the command line.
  
  : array

2. select the arc and circle, then press the Enter key.
  Select entities to array: (Select the arc.)
  Entities in set: 1
  Select entities to array: (Select the circle.)
  Entities in set: 1
  Select entities to array: (Press Enter.)

3. Specify Polar array by typing P and then pressing Enter:
 Type of array:  Polar/<Rectangular>: p

4. pick the very center point of the octagon.
 Base/Center of polar array: (Pick center of octagon.)

 • Make sure your snap and grid is on when you  
pick the center point.

5. set the number of items to 4 and the area (angle) 
 to cover to 360 degrees:
 
 ENTER to specify angle between items/<Number of 
 items to array>: 4

 Angle to array (+ for ccw, - for cw) <360>: 360

6. have the entities rotated as they are arrayed: 

 Rotate entities around the array?  No/<Yes>:  (Press Enter.)

 • Your drawing now has four arcs and circles.

7. At the command prompt, type UNDO, or pick the undo icon.

8. Re-array the arc and circle so that each side of the 
 octagon has an arc and circle.

 • A gap exists between the end of the arc and the octagon.

9. Using the OSNAP commands, draw a line from the end 
 of the arc perpendicular to the octagon side. (Draw the 
 lines on one arc only.)

 • To draw the lines, it will require that you zoom in  
so you can carefully see what you are drawing and 
where the esnap indicators are pointing.

 • You will need to set your ESNAP to endpoint  
and perpendicular.

10. Reset your array command so that you can array the 
 properly drawn extension lines on the gapped arcs only.

Your completed drawing should look like Figure 5.7.

  

 Figure 5.7
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CHAPTER FIVE ASSIGNMENT

Prepare to print a hard copy of dRaW7 by adding a title box 
of your own design. (Create a simple title box like you did for 
Draw2.) Make sure that your title box contains your name, 
personal identification number and Draw7 within the defined title 
box area. Submit for grading.

 • To plot, refer to figure 1.5 and 1.6 for page and layout 
settings, and review Chapter 1 if necessary. 

 • You should have a basic understanding of the following 
terms and actions before proceeding:

Line Drawing a line using keyboard commands

Coordinates Using the keyboard to enter coordinates for  
 drawing lines, arcs, and circles

Mirror Making a mirror image of a drawing

Array (Polar) Arraying a grouped item around another item

If you cannot remember how to operate any of the above func-
tions, go through the chapter again until you are able to do these 
without looking. If you save this drawing again, use a different 
name. Remember, practice makes perfect. 
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chapTeR siX

ReLaTiVe cooRdiNaTes

In the previous chapter we learned how A+CAD records informa-
tion and how data could be added to a drawing while referencing 
the origin point of 0,0. Referencing the Absolute Coordinates 
however, is not the only method of entering data. Relative coor-
dinates are values based upon the last point entered. Relative 
Coordinates can be used when you know the position (or coordi-
nate value) of the last point entered but the only information on 
the next point is relative to the last point. Entering data is preced-
ed with the @ symbol to indicate that the new position is relative 
to the last point and not to the absolute coordinate system.

If a line is to begin at 3,3 the beginning point references the abso-
lute coordinates. If the ending point of the line is unknown to the 
user, but the user knows that the ending point is supposed to be 
three units to the right and five units above the beginning point, 
we would enter @3,5 at the command prompt. A line would be 
shown as in  Figure 6.1.

 

Figure 6.1

The prompt for a Relative coordinate is always @X,Y

The X value always represents the distance and direction along 
the X (horizontal) direction from the last point entered.

The Y value always represents the distance and direction along 
the Y (vertical) direction from the last point entered.

Drawing6 is designed to familiarize you with relative coordi-
nates. Figure 6.2 shows you what we wish to accomplish.

 
 

 Figure 6.2

1. Begin drawing the object shown above (new drawing) by 
 entering the only known absolute coordinate position. At the 
 command prompt, with Line command entered, enter 3,3 and 
 tap the Enter key.

2. Finish the first horizontal line (bottom left) 
 by entering @2,0 and tapping the Enter key. 

 • Note that the line goes two units to the right  
but remains horizontal.

3. Draw the first vertical line by entering @0,1 and 
 tapping the Enter key.

 • The line value went along the X axis by a zero amount, 
but climbed vertically one unit.

4. Continue entering the appropriate relative coordinate v
 alues until the drawing is complete.
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Dimensioning the Object See Figure 6.3

 

 

Figure 6.3

You will need to set your software in the same manner you did 
when dimensioning Draw2. (Chapter 4 – Part II , Dimensioning 
with Precision.) If you have forgotten how to set the software to a 
new dimension style, please refer back to Chapter 4. 

1. Dimension the drawing as shown, and save. (You may 
 wish to save this as Draw8, or Relative Coordinates.)

2. Add the label and information shown in the drawing 
 at the end of the chapter.

3. Add a title block of your choosing and submit for grading.
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CHAPTER SEVEN

RELATIVE POLAR COORDINATES

In the past two chapters we learned how the software records 
information based on Absolute Coordinates and Relative Coor-
dinates. In this chapter we will learn a new method of adding 
data at precise angles. polar coordinates allow data to added at 
angles and not just lengths. Angle Information can be referenced 
to Absolute Coordinates or Relative Coordinates. For example, 
if I want to draw a line and enter 2<45 at the command prompt, 
the software will draw a line two units in length at an angle of 45 
degrees. It will locate the line based upon Absolute Coordinate 
information, (0,0).

If I wish to draw a line based upon the last point, I would enter 
@2<45 at the command prompt. polar coordinates can be used 
when you know the position (or coordinate value) of the last 
point entered, and want to add angular data based upon the last 
point. Entering data is preceded with the @ symbol to indicate 
that the new position is relative to the last point and not to the 
absolute coordinate system. The “less than” sign ( < ) tells the 
software that the next numbers mean angular or degree amounts.

Angular or degree information on a computer is traditionally 
counter clockwise. See Figure 7.1 below. 

 

Figure 7.1

The prompt for a polar coordinate is always @length<angle.

The information following the @ symbol designates the length of 
the line from the last point entered.

The information following the < symbol represents the angle 
from the last point entered. Angle information can go clockwise 
if a minus symbol precedes the angle information; i.e. @2<-45 
would draw a line down to the 315 degree mark. 

drawing9 is designed to familiarize you with polar coordinates. 
Figure 7.2 shows the general layout of the drawing created with 
polar coordinates. 
 
 

Figure 7.2

drawing with Relative polar coordinates

1. Using the line command, begin drawing the inner octagon 
 at the absolute coordinate value of 2.93,307.

2. To create the end of the first line, type @1.00<0 and tap 
 the Enter key.

 • The information describing the length of the line and the 
number of lines is shown in the dimension line for the 
bottom of the octagon.

 • The direction or angle is determined by examining 
  Figure 7.1.
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3. To create the first angled line, type @1.00<45 and 
 tap the Enter key.

4. Continue entering the values necessary to create each 
 line of the octagon until you return to the starting point.

5. Now that you are somewhat familiar with relative polar 
 coordinates, let’s draw the outside octagon. At the Line 
 command, begin the first point of the bottom line by 
 entering the absolute coordinate value of 2.75,2.25 and 
 tap the Enter key. 

6. Proceed around the outer edge by entering the appropriate 
 length and angle of each line.

 
dimensioning the drawing

At first glance, the drawing appears to be a simple dimensioning 
process. A closer look shows us that most of the dimension lines 
have two lines of text. Let’s begin this tricky multi-step process 
by:

1. Pick settings, dimension settings, and New to create the 
 dimensioning characteristics that we want for this drawing. 

 • You should be familiar with process as described in 
Chapter 4.

2. Make the following settings under the appropriate tabs.

 a. At the Text tab, set the text height to .15.

 b. At the Unit tab, set the decimal places to 0.00.

 c. Under the Tolerances tab, turn on the Generate Di-
mensional Limits options (a check mark shows). Set the 
“Decimal Places For” setting to 0.00. 

 •  Your dialog screen should look like the one in 
  Figure 7.3.

Figure 7.3

 
3. Pick oK and save your settings.

4. Dimension the drawing using the Linear command 
 as you have in previous drawings. 

 • Note that as you dimension, your dimensions  
have two identical values. See Figure 7.4.

   
  

 Figure 7.4
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editing dimension Text

Since the software is programmed to enter numerical values only, 
we must edit the dimension text to change the upper value (or 
number) to what is shown in the drawing. 

Dimension editing is normally done with the DimEdit command, 
but this “two-tier” text needs to be edited in a special manner.

1. Double-click the text. Notice the Entity Properties 
 dialog box, as shown in Figure 7.7.

Figure 7.7

2. The override Text box currently reads <>. 

 • The <> is A+CAD’s way of indicating the default  
dimension distance that it calculated based on your  
pick points.

3. Highlight the <> text, and then replace it with 4X\p1.36.

 • The “/P” is a special code that tells the software to  
split the text into two lines (p is short for “paragraph”). 
The “P” must be in uppercase.

4. Click oK.

 • Notice that the dimension text has changed.  
See Figure 7.8.

                                       Figure 7.8

6. Continue to edit each of the dimensions so your drawing
 looks like the drawing at the end of this chapter.

7. Add appropriate labels and titles and submit for grading.
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chapTeR eiGhT -- ModifY

MULTIPLE COPY and ROTATE with the USER 
COORDINATE SYSTEM

This chapter is designed to familiarize you with some of the most 
important modify commands in the A+CAD software. The chap-
ter is divided into three parts and three drawings. Each drawing 
utilizes some or all of the modify commands listed above, and 
of course, the draw commands we have learned in the previous 
chapters are repeated.

part i, draw 10

The drawing shown in Figure 8.1 is a very simple drawing which 
asks you to draw only 12 lines and two circles. The remainder of 
the drawing is obtained through the copy and rotate process. 

 

Figure 8.1

1. Begin the drawing by entering the four lines that 
 form the large rectangle.

 • You may begin the drawing by clicking on grid and then 
snap at the lower right hand corner of the screen. Select 
the line command and draw a rectangle as shown 6 or 12 
grid dots wide by 3.5 or 7 grid dots long. 

2. Reset the User coordinate system (Ucs) to the lower left 
 corner of the rectangle. See Figure 8.2.

  
                    Figure 8.2

 • The User Coordinate System replicates the World Co-
ordinate System, but it can be moved so that entry data 
is based upon the location of the UCS and not the lower 
left corner of the screen.

 • When the UCS is moved to a new location, the number-
ing system begins at the new location.

 • The new UCS location begins the 0,0 system  
all over again.

 • If the origin is not visible on the screen (because the 
drawing is zoomed in), then UCS icon automatically 
relocates itself from the origin to the lower right corner 
of the screen.

3. To move the UCS icon to the new location (lower left corner 
 of the rectangle), type the Ucs command.

 • This command prompts you at the command line.

4. With the esnap active, select the lower left corner of the 
 rectangle and pick when the yellow Endpoint cursor shows. 

  : ucs
  ?/3point/Delete/Entity/Origin/Previous/Restore/Save/

View/X/Y/Z/ZAxis/<World>: e
  
  Select entity for UCS definition: (Pick the lower corner 

of the rectangle.)

 
 • Your UCS icon moves to the lower left corner  

of the rectangle.
  
 • Your drawing should now look like Figure 8.3.
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Figure 8.3

5. You can now draw your first circle. Using the Circle 
 command, enter the values of .5,.5 when asked for the 
 center point location and .25 for the radius. This will 
 locate the circle in the lower left corner of the drawing. 

6. Enter the remaining three circles in top left corner, 
 the upper right corner, and the lower right corner by 
 using the Copy command.

7. select copy and identify the circle in the lower left corner. 
 At the command prompt, type M for multiple copies. When 
 prompt for the base point, enter .5,.5. and then place a 
 circle one grid dot in from each corner of the rectangle.

 • All four circles should now be around the edge  
of the rectangle.

 • Your drawing should now look like Figure 8.4.

 

Figure 8.4

Using the same logic we used to create the rectangle and 
the four circles, we will now build the T part.

11. Begin drawing the T shape by beginning approximately the 
 center of the drawing. Select line and draw one grid dot or 
 .5 over to the left and then continue down 4 grid dots or 2.  
 Go to the right .5.  Continue with line up or 90 degrees .5 

 and then to the right .5.  Continue with line going up or 90 
 degrees 1 and then over to the left .5. and press enter. 

12. Move the Ucs to the lower left corner of the T shape.
 • Moving the UCS to the new T-shape location will  

allow you to use absolute coordinates to enter the  
bottom circle.

  Right click on SNAP at the lower right hand corner of 
the screen and change the snap setting to .125.   Start a 
circle at the location shown.  The radius of the circle will 
be .125.

13. After drawing the bottom circle to the proper size, copy the 
 circle using the “multiple” option, and locate each of the 
 .1,25 circles at their proper locations using Absolute 
 Coordinate values. 

 • Your T part should look like Figure 8.5.

 

Figure 8.5
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14. Relocate (move) the Ucs icon back to the lower 
 left corner of your rectangle again.

 • Relocating the UCS allows you to copy the T-piece that 
you have just drawn to the two ends of the rectangle.

15. Using the Copy “multiple” command again, window 
 the entire T-piece when requested to select the items 
 to be copied.

16. Using your esnap feature, pick the lower left corner 
 of the T-piece when prompted for the base point.

17. When the Command prompt asks you to specify the second 
 point of displacement, type .75,.75 and tap the enter key.

 • A copy of the entire T-piece should now be positioned  
at the left side of your drawing.

18. Since the “multiple” feature is active, the command prompt 
 will immediately ask you to specify another point of 
 displacement. Type 4.38,.75 and tap the enter key.

 • A second T-piece should be inside the rectangle  
and near the right side of the drawing.

The bottom T-piece will require us to use the Rotate command 
before moving the T-piece into position.

19. copy the T-piece a third time and place the T-piece inside 
 the rectangle, near but not touching the T-piece on the right 
 side of the drawing.

20.  Using the Rotate command, (pick the Modify menu, 
 then Rotate, or simply pick the Rotate icon.) 

21. place a window around the center T-piece when asked 
 to select the items to be rotated.

22. Using your esnap feature, select the lower left corner 
 of the T-piece when requested to pick the base point.

23. When the command prompt requests the rotation angle, 
 type 90 and tap the enter key.

 • The angle direction on a computer runs counter  
clockwise; hence our T-piece is now horizontal and 
ready to be moved into its proper position.

 24. To move the T-piece into its proper location, activate 
 the Move command.

25. pick the Modify menu, then Move, or simply pick 
 the Move icon. 

26. place a window around the entire horizontal T-piece 
 when selecting the items to be move.

27. When requested to enter the base point for the items, 
 pick the lower left corner of T-piece.

28. When requested for the “second point of displacement,” 
 type 2.13, .25 and tap the enter key.

 • The horizontal T-piece should now be sitting  
in its proper position.

 • Your drawing should now look like Figure 8.6.

 

Figure 8.6

Using the ordinate dimensioning feature, you should now 
dimension the drawing so it looks like the full-size drawing at 
the end of this chapter. If you have forgotten how to use ordinate 
dimensions, refer back to Chapter 5. (Ordinate dimensions were 
used to dimension the second drawing in absolute coordinates.)

Save your drawing as Draw 10 or as Multiple Copy.

Resave, add a titlebox, plot, and submit your 
drawing for grading.
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CHAPTER NINE

MODIFY COMMANDS: Break, Fillet, Parallel, and Trim

This drawing uses more “modify” commands in its construction 
than “draw” commands. The drawing, a simple gasket, is most 
easily constructed by laying out a template from two simple lines. 
Begin a new drawing in the customary manner.

1. pick the insert pull-down menu and select Infinite Line.

 • In other software, infinite lines are also known as  
“construction lines.”

2. draw a vertical line several inches to the right of your 
 left border.

 • Use snap and grid to ensure that your line is vertical, or 
activate the ORTHO button at bottom of your screen.

 • The exact location of your drawing is not important at 
this time as the drawing can be moved to ensure you 
have sufficient drawing space.

 
 • Infinite construction lines run across the entire length/

width of the screen.

Since the construction line is a solid line covering the entire 
length/width of the screen, we will now learn how to activate 
a new line type so the centerline can be distinguished from the 
solid line. 

3. pick settings, then explore Linetypes.

 • The A+CAD Explorer dialog box displays.  
See Figure 9.1.

Figure 9.1

4. pick the New item button in the upper left corner.  

 • The New Linetypes dialog box overlays the Explorer. 
See Figure 9.2.

Figure 9.2

5, Click the choose from file button.

 • The Select Linetype File dialog box appears.  
If necessary, change Look in to A+CAD’s Support 
folder. Select icad.lin, and then click open.  
See figure 9.3.

Figure 9.3
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• The Linetype dialog box appears. See Figure 9.4.

 

Figure 9.4

6.  slide the slider bar down until Center2X linetype 
 displays, then pick Center2X and the oK button.

 • When the oK button is picked, the Linetypes dialog  
box disappears and the selected linetype is added to  
the Explorer dialog box.

 • Center2X was chosen for this drawing because it is  
most proportionate for this small size of the object  
being drawn.

7. pick on the center2X linetype to highlight it, then select 
 the Current button. See Figure 9.5. Exit the Explorer by 
 clicking the X button in the upper right corner.

 • Since the Center2X linetype has been selected, that  
will be the only type of line the software will draw  
until another linetype is selected.

Figure 9.5

8. draw a horizontal line of about five inches long near 
 the middle of your screen.

 • The construction line on the left and the centerline  
in the middle of your screen will allow you to develop  
a location point for each of the circles.

If you view the construction line as the left edge of our drawing, 
you can now use the Parallel command to establish a vertical 
boundary for each of the circles that needs to be drawn. (This 
command is known as “Offset” in some other software pro
grams.) Be certain to read the dimensions carefully so proper 
offset values are obtained.

9. pick Modify, then parallel.

 • The command prompt will immediately request  
an offset Distance.

10. Type .75 and tap the enter key.

 • The software then asks you to select the entity 
 to be offset.

 • After you have selected the line to be offset, the soft-
ware asks on which side it should make the parallel 
copy. 

11. pick any part of your screen to the right of the vertical line, 
 and then tap the Enter key to exit the command.

 • A second construction line is displayed on your monitor.

 • If you did not tap the Enter key, the software would 
continue to prompt you for parallel lines to the right  
of the last line. 

12. continue to offset the original construction line until a 
 vertical boundary for each circle and the right side of the 
 drawing is placed on the screen. See Figure 9.6.
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Figure 9.6

13. offset the center2X line both upwards and downwards 
 until the centerlines and the construction lines intersect, 
 giving the center point for each requested circle.

 • If you offset the centerline the distance specified to  
create an intersection for each circle, your drawing 
should look like Figure 9.7.

 

Figure 9.7

14. carefully locate the centerpoint of your first circle, 
 and create the first circle with a diameter of .319.

15. Using multiple copy, duplicate your first circle so 
 your drawing looks like Figure 9.8.

 

Figure 9.8

16. carefully locate the center point of the large circle 
 on the left and draw it in.
  
17. carefully locate the center point of the large circle 
 near the top right corner of the drawing and craw it in.

18. copy the large right circle and place it into position 
 directly below. 

 • *.   Your drawing should now look like Figure 9.9.

 

Figure 9.9

Figure 9.9 shows the drawing nearly constructed. We need to 
modify the three large circles so that they become one large 
curved entity. To do that we will use the fillet command. The 
fillet command “rounds” the corners on straight lines or circles. 
In effect we will be drawing something like an arc around the 
designated circles. Figure 9.10 shows what lines will be drawn 
after the circles are filleted.
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Figure 9.10

To create the fillets shown in Figure 9.10, follow the 
procedure below.

19. pick the Modify menu, then fillet. 

 • The command line now asks what you wish to do.

20. Type R (for radius) and type the Enter key.

21. enter the radius value at this time, (.250) and tap the 
 enter key.

 • Command line now asks you to select the first  
entity, the first of the two circles between which  
you wish establish a fillet.

22. pick upper right circle in the upper left corner.

 • Since computer action is always counterclockwise,  
the upper right circle should be picked near the  
upper left quarter of the circle.

23. pick the big circle directly below the small center circle.

 • Keep the counterclockwise rotation of the software  
in mind when selecting the second circle. 

 • A fillet now appears below the small center circle  
and between the two big circles.

24. fillet the remaining circles so that your drawing looks 
 like Figure 9.10.

The line between the fillets now needs to be removed. 
To do that we will use the Break command. Break is 
another Modify command.

25.  pick the Modify menu, then break.

 • The command prompt asks you to identify the  
entity you want broken.

26. pick the upper right circle in the lower left corner.

 • The software now requests you to select a second  
point or pick a new first point.

27. Type f and tap the enter key.

 • If you simply pick a second point on the circle, the  
software will “break” out a section between the two  
pick points. 

28. With your esnaps turned on, use the Int(ersection) option 
 and select the point where the fillet and the circle meet.

 • This will be the first point identified for removal  
of part of the circle.

29. Using your esnaps again, pick the top right circle in the 
 low right quadrant where the top of the rightmost fillet 
 and circle intersect.

 • The lower left corner of the circle will disappear.

30. Using esnaps, and with the counterclockwise rotation 
 in mind, remove the appropriate portion of the remaining
  two circles. (Use Break and Erase.)

 • Your drawing should now look like Figure 9.11.

 

Figure 9.11
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The drawing nears completion. All we need to do now is to 
draw the outside border. To draw the border we will first need 
to establish points at each corner from which we can connect 
lines. Perhaps the easiest method of beginning is to draw a circle 
of the proper size (notice the radius size of .375 on the drawing) 
around each existing corner circle.

31. draw a circle (radius of .375) around each existing 
 corner circle. See Figure 9.12.

 

Figure 9.12

32. With the Tan(gent) esnap setting activated, draw a 
 line from the top of the upper right circle to the top 
 of the big circle on the left.

 • If the tangent setting is on, the software will  
draw a tangent line between the two circles.

  

33. continue drawing tangent lines around the outside 
 circles until your drawing looks like Figure 9.13.

 

Figure 9.13

34. The unwanted portion of the outer circle now needs to be 
 removed. Using the Break command, remove the inner 
 portion of the outer circles that gave us the basis for 
 drawing the border lines.

 • If you need assistance using the Break command,  
refer back to step 24 in this chapter.

 
 • Your drawing should now look like the drawing  

in Figure 9.14.

 

Figure 9.14
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35. Dimension the drawing.

36. erase all construction lines, and all but the 
 Center2X line, and submit for grading.

 • Your drawing should now look like the one in Figure 9.15.
 

Figure 9.15

37. Add the Gasket label and a title block of your choosing. 

38. Save your drawing as Draw11 (or Gasket.)

39. Plot and submit for grading.
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CHAPTER TEN

POLYGONS

Drawing with a computer has many advantages over hand draw-
ing. One advantage is that shapes like polygons have the geom-
etry already created. All the user has to do is specify the size and 
shape desired. In the following drawing, we will learn to use the 
Polygon command along with the modify command, Rotate.

Construction of this drawing will also give us a chance to refresh 
our memory on use of the Parallel command, and the changing/
selection of a different style of linetypes.

1. Begin a new drawing in the customary manner.

2. Using relative coordinates, draw a rectangle with the Line 
 command. Begin it in the lower left corner of the screen, 
 and draw a 4-inch long line.

3. Using relative coordinates, complete the border or r
 ectangle of the drawing.

4. Use the Parallel command to offset the bottom line so 
 you have a horizontal line at the centerline markings 
 for the polygons, and the bottom edge of the large polygon.
 Your drawing should now look like Figure 10.1.

 

Figure 10.1

5. Offset the left border of the rectangle so you obtain 
 intersections for each small polygon you need to draw, and 
 lines designating the edge of the large polygon. Your drawing 
 should now look like Figure 10.2.

 

Figure 10.2

6. Pick the Insert menu, then Polygon, or simply 
 pick the Polygon icon. 

 • The command prompt now asks you to enter the  
number of sides you want your polygon to be.  
Type 6, and tap the enter key.

 • The command prompt now asks you to locate the center 
of the polygon. pick the upper right intersection.

 • The command prompt now asks you to select the vertex 
point (corner point). Type .50 and tap the enter key.

 • A polygon should now be in the upper right corner of 
your rectangle. (Ignore the rotation factor, we will rotate 
the two right polygons after all polygons are entered and 
on the screen.)

7. Continue to draw the two polygons on the left side of 
 the drawing.

8. To draw the large polygon in the center of the drawing, 
 activate the polygon command.

 • Notice the large polygon is an octagon (8 sides).
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 • When prompt for the center of the polygon, type e for 
Edge and tap the enter key.

 • The command prompt now requests you indicate how 
long one of the eight sides of the polygon should be. 
pick the two appropriate intersections obtained by  
offsetting the bottom and left sides of the rectangle  
when starting the drawing. 

 • As soon as the second edge point is picked, the  
polygon appears on the screen. Your drawing  
should now look like Figure 10.3.

 

Figure 10.3

Now that all the polygons have been drawn, let’s rotate the two 
polygons on the right so they look like the drawing at the end of 
the chapter. 

9. Pick Modify, then Rotate, or simply pick 
 the Rotate icon. 

 • Identify the upper right polygon in the usual manner.

10. Select center of the polygon for the base point.

 • Selecting the center of the polygon will allow the 
 polygon to rotate without moving in position.

 • As soon as the base point is selected, the command 
prompt will ask for the rotation angle.

 

11. Move the cursor above the base point and towards the 
 top right corner of the polygon.

 • You will see the polygon move as you swing your  
cursor from right to left.

12. With your esnap activated, pick the vertical line 
 above the base point when the X from the esnap 
 intersection flashes.

 • The point from the polygon should now be upward.
 
13. Repeat the rotation process on the lower right polygon. 

 • Your drawing should now look like Figure 10.4.

 

Figure 10.4

14. Once again we wish to show the centerline location of 
 the polygons. Refer to Chapter 9 on how to load the 
 Center2 linetype. 

15. draw the centerlines as shown on the drawing at the 
 end of your chapter.

 • You can draw right over the lines you used as  
construction lines. The Center2 will remain after  
you erase the construction lines and “redraw.”

 • Your drawing should now look like Figure 10.5.
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Figure 10.5

16. add the illustrations shown on the left side of the drawing.
  
 • You will need to make the “continuous” linetype  

current again.

 • Use a radius of .25 inches for the polygon illustrated, 
and a .5 inch long line for the Edge option.

17. dimension the drawing as shown.

 • You will need to use the “Aligned” option when  
dimensioning the polygons.

18. Label the drawing and polygon illustrations, plot and 
 submit for grading.

 • Your drawing should look like Figure 10.6.
 

Figure 10.6
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CHAPTER EVEVEN

MODIFY COMMAND: CHAMFER

This drawing uses another commonly used modify command, 
“Chamfer.” The Chamfer command has the option of modifying 
corners similar to the Fillet command, but makes angled lines 
instead of arcs. An “equal distance” chamfer setting would 
modify the corner with a 45-degree straight line cut. 
(See Figure 11.1)
 

Figure 11.1

A chamfer cut with unequal distances might look similar 
to the one shown in Figure 11.2.

 

Figure 11.2

The drawing shown in Figure 11.3 is created by using only a 
few insert commands: circle, construction line, line, and 
polygon. Most of the creating was done by use of the following 
Modify commands: chamfer, offset, and rotate.

 

Figure 11.3

Let’s begin the drawing.

1. Using the Line command, create a box nine units (inches) 
 long and eight units tall.

2. Using the Infinite Line command (insert menu), pick the 
 top left corner of your square and then the lower left corner 
 of the square.

 • An endless vertical line goes across your screen.

3. Use the Parallel command to establish vertical offset lines for 
 the circles and the uneven sided polygon (marked “B” in the 
 figure above)

 • Do not draw any construction lines for the “A” polygons 
at this time.

 • Be sure your offset dimensions are correct. Check the 
drawing at the end of this chapter frequently.

 • Your drawing should look like Figure 11.4 at this time.
 
 

Figure 11.4

Now let’s create horizontal offset lines by following the same 
procedure just used above. The intersections of the construction 
lines will serve as our circle and polygon center points.

4. Using the Infinite Line command, pick the top left corner 
 of your square, then the top right corner.

 • An endless horizontal line should now be across  
the top of your screen.
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5. Offset the top horizontal construction line 2.5 inches 
 to locate the center of polygon B.

6. With the Parallel command, offset the top horizontal 
 construction line by 3 inches to locate the intersection 
 for polygon C on the left.

7. Offset the top horizontal construction 5.5 inches to 
 locate the intersection for polygon D.

 • You should now have an intersection for all of the  
polygons with exception of the big polygon that  
will go near the edge of your 8 x 9 rectangle.

8. Offset both the vertical and horizontal construction lines to 
locate the center point for the big polygon. 

 • You should now have a drawing like that shown in  
Figure 11.5.

 

Figure 11.5

Now that we have intersections for the circles, let’s begin 
by adding them. 

9. For the big polygon, draw a circle with a diameter 
 of 8 inches and then draw the polygon.

10. Add the circles for polygons B, C, and D.

 • Your drawing should now look like Figure 11.6.

 

Figure 11.6

11. Add the appropriate size polygons for each circle.

 • Check the drawing for appropriate sizes. 

 • Your drawing should now look like Figure 11.7

 

Figure 11.7

12. Let’s rotate the polygon on the left (C) so it looks l
 ike the polygon on the drawing. 

 • If you’ve forgotten the Rotate command, please refer  
back to the last chapter.

13. And now that we are almost finished constructing the 
 drawing, let’s erase some of the lines and circles we 
 will no longer need.

 • See Figure 11.8.
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Figure 11.8

14. Select chamfer command (Modify menu), 
 or simply pick the Chamfer icon. 

 • The command prompt asks what function we  
wish to perform.

15. Type d (for distance) and tap the enter key.

* The command prompt asks for the chamfer distance 
 on the first entity. enter 1 and tap the enter key.

 • The command prompt then requests the distance for  
the chamfer distance on the second entity. Enter 1 and 
tap the enter key.

16. Press the Enter key to repeat the command. The command 
 prompt asks you to select the first entity. 

 • On the top-most line of your rectangle, pick the line 
near (but not on) the right corner; then pick near the  
top corner of the right side of your rectangle.

 • The corner is cut off at a 45-degree angle between the 
top and side of your rectangle.

17. chamfer the bottom right corner of your rectangle 
 with the same setting of 1.

18. chamfer the left side of your rectangle to a setting of 2.
 • Your drawing should now look like Figure 11.9.

 

Figure 11.9

19 Chamfer the small four-sided polygon with distance 
 settings of .25 and .5.

 • The .25 distance has been set to the first line picked.  
The .5 distance will be applied to the second line.

 • If you pick the wrong lines and the chamfer does not 
look like it does in the drawing, just pick the undo 
command to restore the polygon so that you can pick 
opposite lines the second time. Experiment until you 
can readily apply the Chamfer command with different 
distance settings.

We are now ready to construct the final two polygons and 
finish our drawing.

20. Offset the upper and lower right corner lines by .825 with
  the Parallel command. (The 45-degree lines were created 
 by the Chamfer command.)

 • This offset line provides the center point for the circle 
we need prior to entering the desired polygon.

21. Using the Circle command, draw a circle (diameter of .75) 
 at the midpoint of the offset line.

 • A .75 diameter circle should be drawn at both the top 
and bottom of the drawing. (Right side only.)

22. draw a four-sided polygon (square) around the circle.
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23. Chamfer the points of both squares that are closest to 
 the big polygon and the box chamfer line. (Use a 
 distance setting of .25.)

24. Erase the offset lines and the construction circles 
 from the last two polygons.

 • Your drawing should now look like Figure 11.10.

 

Figure 11.10

 
25. Dimension your drawing so it looks like the 
 drawing in Figure 11.11.

Figure 11.11

26. Add the circle and polygon construction information 
 shown in Figure 11.12.

Figure 11.12

27. Save as usual, plot, and submit for grading
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CHAPTER TWELVE

cabiN fLooR pLaN 

Objective: This exercise will familiarize you with the commands 
Units, Insert, Zoom All, Fillet, Parallel, Dist, Break, Hatch, 
DimLinear (horizontal and vertical dimensions), and relative 
coordinates. For this lesson you will be using the Insert, Modify, 
View, and Tools menus.

You will use many of the commands you have learned from 
previous chapters, and will be entering coordinates by positioning 
the mouse and by using the keyboard. 

To draw the outline of the house, we will again use Polar 
Coordinates as we did when making the title block (Chapter 2). 
In review, polar coordinates are best described as being able to 
draw lines of precise length and angles -- all in one command. In 
Figure 12.1 it shows that the point of departure remains the same 
regardless of which direction you draw.

Figure 12.1

You will be drawing a floor plan of a small cabin. There are three 
floor plans to choose from. If you choose the version C, you 
will earn a C for this drawing. If you choose version B, you will 
earn a B, and if you choose version A you will earn an A. Every 
version builds on the last, with C being the most simple and 
version A the most complex. It is important to study the drawing 
you choose before beginning. This will give you an idea of what 
you need to accomplish. 

Refer to the drawing often so that you know you are on track. 
Each step is necessary to construct the drawing shown in the 
following exercises. Follow each step carefully and watch how 
your computer responds to the different commands you give it.

Selecting the Settings

You will now select the settings for your drawing. It is important 
to select the settings before you begin drawing a floor plan, since 
you draw in actual dimensions.

1. select the settings menu, then drawing settings. 

 • A Drawing Settings dialog box appears.
 
 • Choose the drawing Units tab, and then “Linear Units” 

from the change setting for droplist, as shown in  
Figure 12.2.

Figure 12.2

2. Under the Unit Type heading, change to architectural.

 • The text in the preview rectangle changes from  
decimal to feet/inches/fractions.

 • Architectural measurements of feet and inches are  
customarily used for floor plan drawings instead  
of decimals.
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3. change the display precision to 3.

 • This sets the display accuracy of your drawing to 1/16th 
inch. While you can still specify values that are small, 
A+CAD will display the maximum accuracy to 1/16th 
inch.

4. pick the coordinate input tab, then change Change 
 Settings For to “Limits.”

 • The Lower Left is at 0,0. This is a very good place to 
draw from and we will not be changing that value.

 • The upper right value needs to be changed. A common 
formula for determining the size of the drawing limits is 
to take the width of the drawing you are about to create, 
and add 50% additional space for dimensions, notes, 
details, etc. 

 • Since our cabin measures 34’ x 24,’ drawing width (X 
value) should be set for 34’ + 17’ or 51’. Our height or  
Y value should be 24’ + 12’ or 36’.

 • To determine exact limits, we must first determine what 
size paper the drawing will be plotted on. In this case we 
will plot on 8.5” X 11” paper.

 • Common scales used for architectural drawings are:

Scale     Scale Factor
   
½” = 1’-0” or 24
¼” = 1’-0” or 48
1/8” = 1’-0” or 96
1/16” = 1’-0” or  192

 • if we divide our X value, 51’ (612 inches) by the  
11 inch paper width, we determine our scale factor  
is 96. (The scale factor of 48 is seemingly too small  
but let’s check further.)

  51’(object length) X 12” = 612” 
  (total inches of object + 50%)
   

612” / 11” (paper length) = 55.6 or 56 (Scale factor)
  
 Our necessary 56 exceeds 48; therefore, we need to move up 
 to the next commonly used scale, which is 96. 

 • if we divide our Y value, 36’ (432”) by the 8.5 inch 
length, we determine our scale factor is 96. (Again scale 
factor of 48 seems too small so we jump to the next 
scale factor large enough to work and that is 96.) 

   
36’(object length) X 12” = 432” (total inches of object)

   
432”/ 8.5” (paper length) = 50.82 or 51 (Scale factor)

 
  Again 51 still exceeds the scale factor of 48, and we 

select 96. (The next available common scale.)

 • The addition of 50% working area beyond the object 
size is only a guideline, however a scale factor of 96 is 
chosen to allow for the multiple dimensions that will 
need to be spaced quite a distance from the outline of  
the cabin.

 • Our exact limits are then determined to be:

  96 X 11” or 1056” (88’) -- X axis

  96 X 8.5” or 816” (68’) -- Y axis
  
5. enter 88’, 68’ to establish the upper right boundary limit.
  See Figure 12-3.

Figure 12-3
 • You must add the apostrophe behind each number, and 

the comma must separate each number. Otherwise, the 
software reads the numbers as inches.
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 • Nothing appears to happen. We must tell the software to 
view the much larger drawing area before anything can 
be drawn.

 • Note the numbers in the center of A+CAD’s status bar. 
These are the x,y coordinates. Move your cursor around 
and watch as the numbers register the absolute values of 
the cursor. Move it to the far right and then to top right 
to see the maximum default sizes.

9. Pick the View menu, then Zoom, then All.

 • The coordinates for the cursor location in the very right 
corner of your screen change. (Move your cursor around 
and note how large the numbers are now.)

 • You should now have a large drawing screen and be 
ready to draw.

drawing the exterior Walls

Objective: You will now draw the exterior walls of your floor 
plan, using a combination of selecting points with the pointer 
and entering polar coordinates on the keyboard. Remember that 
it is important for you to look at the drawing that you have 
selected to ensure accuracy. If you make a mistake use Erase 
or Undo to fix it. 

1. select Line under the insert menu, or pick the Line icon. 

 • You will now mark the starting point of the first line  
by positioning the pointer and clicking.

2. position the pointer approximately 3 to 4 inches to the right 
 of the origin along the X axis, and about 2 to 3 inches above 
 the origin along the Y axis. Click the left mouse button.

 • This marks the lower left corner of the Greatroom.

 • You will now mark the ending point of your first line  
by entering the polar coordinates listed below.

3. Type: @34’<0 then tap the enter key. Be sure to use the 
 apostrophe (‘) mark after 34. (The apostrophe tells the 
 software you want feet, not inches.) 

 • The polar notation tells the software that you want  
to draw a line from your origin point 34’ in the zero 
direction (East).

4. When the “End point” prompt displays at the command 
 prompt, type: @24’<90 and tap the Enter key.

 • This means you are drawing a line from an existing 
point 24’ in the 90-degree direction (North).

 • You are now ready to draw another horizontal line mark-
ing the northern side of bedroom #1 and the bathroom.

  
 • Continue to go around the house adding the values listed 

below. If you should make an error, simply tap the Enter 
key to finish that line. You may then erase a wrong line. 
Using the entity snap “endpoint” you may restart from 
wherever you stopped. Use the coordinate values listed 
below to continue.

 
5. Type: @34’<180 and tap the enter key.

 • Next we will close the outer rectangle to finish  
the perimeter of the cabin.

6. Type: @24’<270 and tap the enter key.

 • This means you are drawing a line from an existing 
point 24’ in the 270 degree polar direction (South).

  
 • An alternate method for finishing out this exterior cabin 

boundary is to “close” after three of the lines are drawn. 
To activate the “close” command, simply type the letter 
“c”, for close, to finish the cabin rectangle. (You cannot 
“close” the rectangle if you stopped and restarted while 
drawing the four lines.)

  
 • The outline (exterior wall) of the cabin is now complete.

You are now finished with the exterior walls. Check 
Figure 12.3 to make sure that your drawing is correct. 
If you feel comfortable with the accuracy of your drawing, 
continue on to the next section.
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Figure 12.3

 
Modifying the exterior Walls

Objective: You will modify the exterior walls by giving them 
thickness. We will use the Offset and Fillet commands under 
the Modify menu.
  
1. If all of your exterior wall lines are not showing, 
 pick the View menu, then Zoom, and All. 
 
 • You will now add thickness to the walls by copying  

the exterior wall line segments. 
  
2. pick the Modify menu, then parallel, or simply pick 
 the Parallel icon.

 • The command prompt requests the distance that the 
second line should be placed from the first line.

3. Type 6 and tap the enter key.

 • This causes our interior wall line to be six inches  
in from the exterior walls.

 • The six inch setting is standard for log pole construction 
walls, although some cabins are built of thicker stock 
materials.

 • The command prompt now asks which line will  
be made parallel.

4. pick the line on the left.

 • The command prompt now asks which side to  
place the parallel line.

 • pick to the right or inside of the rectangle.

 • A line identical to the first is created six inches  
inside the exterior wall outline.

 • continue to go around all of the exterior walls with  
the offset command.

You should now have two complete outlines of the cabin. 
Unfortunately the interior lines overlap on the corners. 
We will fix those by means of the Fillet command.
  
1. pick the Modify menu, then fillet, 
 or simply pick the Fillet icon.

 • The radius must be set on the Fillet command before  
it will be useful to us. For a sharp smooth corner,  
a radius of 0” must be set.

2. Type R for radius, and tap Enter.

3. Type 0, and tap the enter key.

4. The Fillet command asks you to “Select first entity.”

5. pick near but not on the endpoint of the first line that 
 you want filleted.

 • The entity snap “endpoint” should now be turned off.

6. pick the second line that should come to a sharp 
 point -- near but not at the end of the line.

 • Notice the perfect right angle corner that has  
been formed.

 • If you’re having trouble seeing or grabbing the correct 
lines, zoom in so you can see better.

7. select another corner that needs to have the corners filleted. 
 Tap the enter key to reactivate the Fillet command filleting 
 each corner. 

8. Go around your drawing and fillet all of the interior lines. 
 Continue until all the corners are no longer crossed 
 or gapped.
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You have now completed the second part of this drawing by 
modifying the exterior walls to signify wall thickness. 
(See Figure 12.4). If you feel comfortable with this then 
go on to the next section.

Figure 12.4

drawing the interior Walls

Objective: You will now draw the interior walls of the floor plan 
using the Line, Copy, Move, Parallel, and Dist commands under 
the Draw, Modify, and Edit menus. This exercise will teach you 
how to determine where your walls are placed by having the 
computer measure specified distances for you.

CONCEPT

There are two methods used for measuring. The Dist 
command reports the length of a line between two pick 
points without recording any information on the screen. 
The DimLinear command draws Horizontal or Vertical 
dimension lines, complete with extension lines, arrow-
heads and length of a line of the two points picked on the 
screen. The Dist command is located in the pull-down 
menu through Tools, Inquiry, Distance. To use the Dist 
command, pick two points to obtain the distance between 
them. This is much quicker to use than the official dimen-
sion command, because no entities are left on the drawing 
screen. All information is shown in the command  
prompt area.

To draw the interior walls it will be necessary for you to zoom 
into a designated area first. Draw the interior walls as similar 
as to Figure 12.5 as possible, so that your room sizes are 
approximately the same as the example. Inside walls should 
have a 4” thickness. Study the example often for accuracy.

1. Reset the grid to 4”.

 • If a message appears, “ The grid spacing is too small to 
display in this view,” then zoom closer into an area you 
wish to work on. The grid should now become visible. 
You may use the GRid button shown at the very bot-
tom of your monitor to toggle the grid off and on. (If the 
button is “gray,” the grid is not active.) 

 • Your wall lines will probably not align to the grid marks. 
That’s alright, because we are using the grid for  
approximate values. (You’ll want snap turned off.)

 • You can now begin by drawing in the interior lines of 
the bedroom #1.

2. Using the Dist command, determine the approximate 
 location of the first line.

* At the command prompt, type in Dist and tap the 
 Enter key, or use the pull-down menu Tools, Inquiry, 
 and Distance.

 • Follow the command prompt and pick a second location.

 • The command prompt gives the distance between the 
two points you picked.

 • Remember we are using the DISTance command to 
obtain a general perspective of where the room lines 
should go. Once you have a general location, it is easiest 
to use polar coordinates to draw a line of exact length. 
Note the next two steps.

3. Starting from the inside of the exterior walls, and by using 
 your esnaps and the polar command, draw a line of the 
 length specified for the room size.

4. draw a second line (from the inside of the exterior walls) 
 at a perpendicular angle to the last line drawn.
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 • This will allow you to obtain room sizes very close to 
those specified in the book.

 • This procedure will require that you “break” some lines 
and trim out portions that you don’t want, but drawing 
lines of the required length is an easy way of getting the 
room sizes established before adding more detail.

5. offset your wall lines by 4” with the Parallel command to 
 obtain thickness. Complete all interior walls.

6. To break lines so that doors, windows, hallways, etc. can be 
 shown, it will be necessary to use the break command and 
 to cut out portions of lines where appropriate. 
 
7. To break a line, we must pick the Modify menu, then 
 break, or pick the Break icon.

 • The command prompt instructs us to pick the object to 
be broken. (Note the prompt, “Select entity to break.”)

 • pick the line to be broken.

 • The command prompt now asks us if the point we have 
picked is where we want it to be, or if we want to enter a 
new first point. It is generally best to type F and reselect 
the beginning point of the area we want cut out.

8. Type f and tap the enter key.

9. Accurately reselect the beginning point of the area 
 you want removed.

 • The command prompt now instructs you to pick the 
second point, thus determining the amount of line to  
be removed.

10. pick the second point and watch the line disappear between 
 the two points you have picked.

11. Using the distance command, continue to go from room to 
 room “breaking” lines for doors, windows, hallways, etc.

12. After you have broken the lines, it will be necessary to 
 connect the parallel lines with a short junction line. If you 
 complete this process properly, your drawing will look like 
 the drawing in Figure 12.5

NOTE

It is important for you to check your drawing several 
times as you go along to make sure you are on track. The 
rooms don’t have to measure exactly to the dimensions 
shown on the drawing at the end of the chapter, but they 
should  
be close.

Hallways and walkways should be a minimum of 3’-0” 
wide, and today most rooms are built with 3’-0” doorways 
to meet the needs of the handicapped. Closets should have 
a 2’-0” minimum interior measurement. Kitchen counters 
are usually 2’-0” deep. 

Figure 12.5

Once you have all the interior walls drawn, check figure 12.5 
to make sure that they are correct; then go on to the next part. 
(If you’re on a roll with the Break command, you may want to 
cut out areas for the windows at this time. Note Figure 12.6.)

Labeling the Rooms

Objective: This exercise deals with labeling each of the rooms 
with their name and size labels. You will be using the Text 
command under the Insert menu.

To type the text, it is easiest to zoom into a designated area first. 
After you have zoomed into a room, use the Text command to 
type the name and dimensions of the room. 
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1. pick the insert menu, then Text.
 • The command prompt will ask you to pick a start point. 

2. pick a start point that looks look a good place to locate
  the text.

 • The software now asks you for the height of the text. 
(The command prompt will probably show a default 
value of 1/4th inch.)

 • A proper size for the text must be determined. The de-
fault value was fine when we were creating and plotting 
drawings on an 11 x 8.5 inch sheet of paper. At that time 
our limits were set by default for 12 x 9 inches. Remem-
ber we reset our limits to 88’ X 68.’ If we used the text 
default size of 1/4th inch, our text would be so tiny most 
people would declare that the command had failed to 
work. Therefore, we must reset our text to a more rea-
sonable size -- or at least a size proportional to the rest 
of the drawing. 

 
 • If we assume we would like our text to be 1/8th inch 

when we plot our drawing on an 11” X 8.5” sheet of 
paper, we need to calculate our text size. If we multiply 
our desired text height (1/8 or .125) times our scale fac-
tor of 96, we obtain a value of 12. Twelve inch letters on 
a theoretical sheet of paper 88’ wide seems much more 
reasonable.

3. enter a height value of l2.
 
4. enter a rotation value of zero.

5. Type the appropriate label for the room.

6. continue labeling each room and entering the room sizes 
 until your drawing looks like the drawing as illustrated in 
 Figure 12.6.

   

Figure 12.6
setting Up the drawing for dimensioning 

Before we can dimension our drawing, we must make many 
changes to the dimension settings due to the fact that our 
drawing is much larger than the defaults given automatically 
by the software. Remember how we had to set our text much 
larger than the 1/4” setting which the software gave us by default.

To begin making changes to the dimensioning settings, we must 
carefully follow the steps below. Such settings should be made 
before dimensioning every drawing.

1. pick the settings menu, then dimension settings.

 • A Dimension Settings dialog box appears.

 • The dialog box shown is the same one used when  
we dimensioned our second drawing, Draw2.

2. pick the “New” button at the top.

 • A “New Dimension Style” dialog box appears.

 • Type in the name cabiN. Click create. 

3. pick the arrows tab, then the down arrow, in the lower 
 right, in the “Starting Arrowhead” category.

 • A droplist appears with many options for the ends  
of the dimension lines.
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4. pick “architectural Tick.”

 • Repeat for Ending Arrowhead.

 • Note the default size setting of 1/4-inch,  
change to 1/8- inch.

 • Now, just as we had to increase the ¼” inch text height, 
we must also increase the 1/8-inch “architectural tick” 
by a multiplying by our scale factor. (We will do this by 
adjustments to the Dimensioning Settings dialog box.)

  
5.  Next pick the Units tab at the top of the of this same 
 “Dimension Settings” dialog box. 

 • pick the down arrow next Format, and select  
the word “architectural.”

 • pick the down arrow (right side of the white rectangle) 
in the decimal places droplist.

 • Change it to 3 (1/8 inches).

 • Note the scale of 1.000 in the rectangle  
“Comprehensive Scale Factor.”

 • Enter the value of 96.

 • By entering the value of 96 in the overall scale window, 
we have multiplied all dimensioning default values by 
96. Hence the architectural tick that was listed as 1/8th 
inch in size is now 96 X .125 or 12 inches in size.

 
6.  Next pick the Text tab within this same dialog box.

 • Note the “Text Alignment” area in the lower  
left corner of the dialog box.

  
 • Pick the down arrow next to Vertical.

 • pick the “above extension Lines.”

7. pick save.

 • All of the settings that you have made in all of the 
tab boxes have been saved under the name of Cabin. 
If you had not entered a name and saved the settings 
under some name other than Standard, all default set-

tings would have been changed. The next time you or 
someone else used your software, the default settings 
would have been those that you established under the tab 
boxes. Soon you would not know what sizes or values 
were industry standards, and your dimensioning proce-
dures can become complex and operate inconsistently.

 • Next to Dimension Style (top left), notice that Cabin in 
now the current dimensions style.

8. pick oK.

 • The Dimension Settings dialog box disappears.

 • You must pick Close as you leave the dimensioning dia-
log boxes. If you pick the cancel button, all values and 
settings that you have just made will be canceled and the 
default values will return.

 • You should now be ready to begin dimensioning. Only 
one more setting to make.

9. activate “endpoint” option under entity snap settings.

entering dimensions

1. Select the insert menu, pick dimension and 
 Linear or simply pick the Linear icon.
  
 • The DimLinear command allows you to dimension 

horizontally or vertically without having to select sepa-
rate settings. After you have picked the first point, the 
software senses whether to enter vertical or horizontal 
depending upon where you pick the second point.

 • The command prompt will now ask you to pick the  
beginning of the dimension line. (“Origin of first  
extension line.”)

2. pick the lower left corner (outermost line) of Dining area.

 • The command prompt will now ask you pick the  
“Origin of second extension line.”
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3. pick the innermost corner of the Kitchen immediately 
 to the right of Dining area.

 • The software now waits for you to indicate where you 
want the dimension to be located.

4. drag your cursor down until the location is similar to the 
 one shown in Figure 12.7, then pick.

 • A dimension should appear which looks very similar  
to the one in Figure 12.7.

5. pick the insert and dimension menus, 
 then continue.
 
 • The command prompt now requests a  

“ Origin of second extension line.”
  
6. pick the outermost line at the lower right corner of the house.

 • The software automatically enters the proper value of 
the new dimension, and places it directly to the right of 
the first dimension.

continue dimensioning the remaining dimensions as 
shown in Figure 12.7.

You have now completed drawing C, which is worth 60 points. 
If you want to draw either drawing B (80 points) or A 
(100 points), study the drawing carefully and add the 
necessary features.

   
  

  

Figure 12.7

saving and printing The floor plan

Objective: In this exercise you will save and print your drawing. 
You will be using the Save and Print commands under the File 
menu. The plotting exercise will be similar to that used for the 
Titleblock drawing. The main difference is that we plotted 1=1 
for the Titleblock, and this time we must plot at a scale factor 
of 96=1.

If you plan to terminate your drawing at this point, add a simple 
title box that displays your name and student identification 
number and make a hard copy to submit for grading. Instructions 
for plotting this scaled drawing are listed below. If you plan to 
continue on for a grade of B or A, save your drawing and 
continue on to the “B” drawing instructions.

1. save this drawing as CabinC.

 • You will now print your drawing. Since you drew this in 
architectural scale and to true size, you must set the plot-
ting area in accordance with the size of your drawing.

2. Type Zoom, then e for “extents.”

 • We will prepare this drawing for plotting in the same 
manner that we have prepared all other drawings.

3. activate the print command. When the plot dialog box 
 appears, make the following settings. 

4. Click print Setup.

 • Next to Name, select “hp Laser iii” (or another plotter 
your instructor has made available.)

 • Ensure orientation is set to “Landscape.”

 • Under paper, select “Letter.”

5. Click oK.

6. Under the advanced tab, under print style Table, select 
 “icad.ctb” or any other print style table (pen assignment) 
 you want.

 • Under print offset, select the “center on page” box.
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7. Under the scale/View tab, under print area: select “extents”

 • Under print scale:, change the droplist from  
“Scale to Fit” to “Custom.”

 a. The Printed Units shows a value of 1”.  
This entry is correct. 

 

 b. The Drawing Units must be changed to our scale 
factor value of 96”. Change the Drawing Units to 
96. (This establishes a  value of 1” of plotting paper 
space equals 96 units of drawing area.)

8. Perform a “print preview” to determine how your 
 drawing will appear. 

 • Pick print to actually start the plotter.

9. Turn in CabinC to be graded or go on to the next 
 section for a higher grade.
 
drawing b & a -- continuing on

To receive a B (80 points) or an A (100 points) for this drawing, 
you will need to add to CabinC. Study the B drawing. You will be 
using many of the skills you have already learned. You will be 
adding some labels and new areas (i.e. linetypes, solid fill, etc.) 
as shown in Figure 12.10.

 

Figure 12.10

creating solid Walls between the doors and Windows

Objective: In this exercise you will fill in the walls, creating doors 
and windows. You will be using the Hatch command under the 
Insert menu.

HELPFUL HINT

After you have drawn exterior and interior walls, you fill 
them in to denote solid walls. You will use lines to close 
off the areas where there are doors and windows. You 
will leave open (unfilled) areas for doors and windows 
to denote areas that can be opened or closed. Before an 
area can be hatched (filled with lines or solid coloring) the 
area must be completely closed. Lines MUST be drawn 
using the entity snap settings to prevent leakage of the 
hatch pattern. The area to be hatched must be completely 
sealed like a container that holds water; the tiniest gap 
will prevent the hatch (fill) function from working. Study 
Figure 12.10 carefully for the placement of doors and 
windows, then make sure that each area of wall between 
the doors and/or windows is completely sealed. Zoom in 
very closely to check each area if necessary. Exterior lines 
will need to be broken (use the Break command) in order 
to create separate containers for the walls in order for the 
Hatch command to work.

1. Examine Figure 12.10 to determine the areas where the doors 
 and windows are to be placed. Draw lines for the sides of 
 the openings making sure the lines touch the wall lines. 
 (You should have this completed by now.)

2. Zoom into the lower left corner of bedroom #2. 
 (When zooming, zoom by window and place the window 
 slightly to the left of the bedroom window. The other corner 
 of the zoom window should go just below the lower window 
 and only a small amount to the right of the left corner of 
 the window.

 • Zooming this small area will enlarge the lower left 
corner of the drawing so much that you should be able 
to see if there are any gaps in the lines. If any gaps exist, 
you must close the gaps using the endpoint setting of 
Object Snaps, or redraw the entire line. All intersections 
must close perfectly. (You may be able to use the Extend 
command under the Modify menu.)
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3. If the L shaped wall segment appears to be 
 “water tight,” pick the insert menu, then hatch, 
 or simply pick the hatch icon.

 • The Boundary Hatch dialog box appears.

4. pick the “pattern” tab.

 • The Pattern tab lists the names of all available hatch 
patterns shown on the left, and pictures of the patterns 
shown on the right.

5. pick the “solid” pattern, then pick the boundary tab.

6. pick the “select area” button.

 • The command prompt now asks you to select a point 
inside the area you want to become solid.

7. pick a point inside the area to be hatched.

 • The boundary lines become dashed.

 • If A+CAD reports that “The area you selected is not 
valid,” it generally means your intersections are not gap 
free. An option that sometimes works when the “pick 
points” function won’t, is the “Select Entities” button. 
Pick the Select Entities button and then pick each indi-
vidual line of the area to be hatched. (If a window will 
work when selecting the lines, go for it!)

8. Tap the enter key.

 • The Boundary Hatch dialog box reappears.

9. pick the oK button.

 • Your drawing screen returns with the solid fill  
hatch pattern in the defined area.

10. Zoom to another area to be filled and practice 
 steps 3 - 11 again. 

 

• Continue to fill the exterior walls, leaving room for  
windows and doors. Continue with each area of the 
drawing until your drawing looks like the drawing 

shown in Figure 12.10.

 • It’s very important to leave openings for the windows 
and doors before pattern filling an area because you 
cannot come back later and erase an area for a door or 
window without erasing the total pattern fill.

11. fill in all the walls.

12. Save your drawing as cabinb. 

Below are some additional commands you will need to know 
for Drawings B (Figure 12.10) and A (Figure 12.11):

Add the dashed lines as shown in the drawing. The instructions 
for setting the software to dashed lines is illustrated below.
 

Line Type Scale: 
 
If your linetype appears to be a solid line, you must 
change the linetype scale. To change your linetype scale, 
simply type in LtScale.

Copy Command: 
 
Remember, when having to make several objects the 
same, use the copy command under the Modify menu.

Rotate Command: 
Once an object is drawn and grouped (made into a 
block), it can be rotated. You should be quite comfort-
able with command after the Schematics drawing. 

Break Command: 
 
If you want to move an object over an area already 
drawn, you can erase whatever is under the new drawing 
by using the break command found under the Modify 
menu. Turn off the snap command. Select the line, box, 
etc. you wish to erase part of by clicking on it. Click at 
the first point you wish to erase. Click at the end of the 
area you want to erase. It will be gone.
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To receive a B (80 points) or an A (100 points), you must make 
the drawing look similar to the drawing selected. (Drawing 6B or 
6A) The drawing does not have to be exact, but it must be very 
close to the drawings as shown. Experiment with the commands 
as you continue; this is a good way to learn the program.
If you decide to go on for the “A” grade you will need to do 
some additional drawing and add additional dimensions to your 
drawing. Both the B and A drawings require that you insert 
your title box drawing (created as Draw4) into your Cabin 
drawing. You must finish the “Inserting a Title Box” if you 
want a “B” grade. Note the following steps.

Figure 12.11

inserting a Title box

Title blocks are usually plotted from paper space. You must 
therefore, use the same settings or preparations that we used 
when we prepared for Plotting Drawing Four (Chapter Seven). 
Listed below are the procedural steps you need to plot the house 
drawing using Paper Space. If you need additional detail or 
explanation, please refer back to the chapter on “Plotting to 
A Precise Scale.”

1. pick the VieW menu, then Zoom, extents.

 • The display will zoom out showing your house  
at the largest possible size. 

2. Pick the “Layout 1” tab, as shown in Figure 12.12.

 • Notice that the screen goes blank. Don’t worry!  
We’ll bring back your drawing soon. 

Figure 12.12

3. From the insert menu, choose insert block. We are 
 going to insert a title block from the drawing you 
 created in an earlier chapter.

 • Click from file, and then click browse.

 • In the Insert Block dialog box, choose the folder  
that stores your drawings.

 • Select “Draw2-Border.dwg,” and then click open.

4. Back in the first dialog box, turn off the position block 
 When inserting option, because the default values of the 
 options are just fine. We want the drawing to be inserted 
 full-size, because it fits standard 8.5 x 11” paper just fine.

 • Leave insertion point at 0,0,0.

 • Leave scale factor at 1, 1, and 1.

 • Leave Rotation angle at 0.

5. Turn on the option explode block Upon insertion, 
 so that it can be edited. See Figure 12.13.

Figure 12.13
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6. Click oK. The title block is inserted in the drawing.

 • Zoom the drawing so that the title block fills  
the window.

7. The next step is to create a viewport. This lets us see the 
 cabin drawing inside the title block. First, though, thaw 
 layer VpLayer (short for “viewport layer”), and then 
 make it current.

 • On the Entity Properties toolbar, click the down arrow 
next to the layer names.

 • Next to Vplayer, click the snowflake icon. It turns to  
a sun icon. This thaws the frozen layer and makes it  
visible. See Figure 12.14.

 • Select the layer name. The Vplayer layer is now current.

Figure 12.14

8. To create the viewport, choose View and then 
 Layout Viewports.

 • The software prompt you, “First point.” Pick a point in 
the upper left corner, inside the drawing border.

 • The next prompt is, “Opposite corner.” Pick a point in 
the lower right corner, also inside the border. See Figure 
12.15. The cabin reappears!

Figure 12.15

9. To make the viewport border go away, make 
 layer 0 current, and then freeze layer Vplayer.

10. Return to model space inside of paper space” 
 by double-clicking p:Layout1 on the status bar.  

11. Zoom to 1/96Xp.

 • Your cabin drawing is now properly scaled inside  
your title block drawing.

 • If necessary, move your drawing so that it is equally 
margined. Use the arrow keys on your keyboard to move 
the drawing. Moving the drawing once it is properly 
scaled will not affect the accuracy of the drawing.

11. Return to paper space by double-clicking M:Layout1 
 on the status bar.  

 • Remember that you must plot from paper space if you 
want to plot accurately 
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CHAPTER 12 ASSIGNMENT

Once you have added all the necessary items, save the drawing as 
either Draw6A or Draw6B. 

Make certain that your name, personal identification number, etc. 
is on your drawing and submit it for grading. 

Label the drawing with the grade expectation you attempted. 

See drawings C, B, and A. Make your drawing look like 
one of these drawings.
 
 
 

CONGRATULATIONS! You have just completed the course 
requirements for this Computer Aided Drafting/Design course - 
Introduction to Computer Aided Drafting. 

At this time you should: 

1. Be confident that you can construct a drawing of your own 
 design, without help from a procedure manual.
 
2. Be knowledgeable of A+CAD software.

If you are not confident in the items listed above, review and 
repeat those areas that have given you trouble or concern.

If you wish to continue drafting on the computer, please inquire 
about other computer-aided drafting courses that are offered by 
The CAD Academy.

Any comments you have will be gratefully accepted. They will 
help improve the book for those who follow you. 
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